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1.0 Introduction to the Taxonomic Editor

The Taxonomic Editor has been developed as part of the EDIT Cyberplatform for Taxonomy; a
collection of tools and services which together cover all aspects of the taxonomic workflow. EDIT is a
collection of 28 leading European, North American and Russian institutions formed in the response
to a call of the European Commission, issued in 2004, for a “network in Taxonomy for Biodiversity
and Ecosystem Research”.

Development of the Taxonomic Editor is part of EDIT Work Package 5: Internet Platform for
Cybertaxonomy: Tools, Sharing, Networking and Integration. The tools are all open access, free, do
not require licenses, and are downloadable from the EDIT website. Data stored in the Taxonomic
Editor will be linked to other applications of the Cyberplatform via the Common Data Model (CDM)
Library, where the data is stored. So, for example, your Taxonomic Editor dataset can be easily
published online using the EDIT DataPortal application that can extract your data from the CDM. No
data transformation is required by you. The Editor also supports importing and exporting in a range
of databases and taxonomic community data formats and import from Excel.

The goal of the Taxonomic Editor is to provide a next-generation tool that moves beyond the form-
based data entry of web-based tools like the Berlin Model Web Editor. It has been designed with
specific philosophies giving the user:

1. All the benefits of a database without rigid data entry rules.

A unique feature of the Taxonomic Editor is its parsing capability. Parsing is the action of recognising
distinct elements within a string. This means that data can be entered as ‘free’ or unstructured text,
and as you type the parser separates each element of the text string and puts them into the correct
data fields within the database. This makes data entry easy, but also enables manipulation of data as
in a standard database.

The core workflow involves:

i Entering data as a normal text string in a taxonomic style.
ii.  The datais parsed as it is entered.
iii. Reviewing whether the data has been parsed correctly and editing if necessary.

2. Ability to enter data in the format required by the user.

A second defining feature of the Editor is that it has been designed to minimise system intervention
so as not to hinder the work flow. Rather than enforcing data integrity upon input, warnings are
given when any rules have been broken. When the mouse hovers over data that has been marked as
problematic, the problem will be explained, along with possible corrections, however the software
will not force you to change your data.
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3. Useability and customisation options.

The Editor has been designed to feel intuitive keeping the number of new movements or gestures
you must learn to a minimum. Also, the Taxonomic Editor allows for individual customisation of the
fields within the data entry sheet to facilitate an efficient data entry process. For example, you can
choose which taxonomic relationships and rank types are given as options, and for some data fields
you can create your own options. There are also separate configurations for users using the
Botanical and Zoological Codes of Nomenclature.

You will notice that not all of the features of the Taxonomic Editor are yet functional; development
of the application and the manual are still ongoing. Version 3 of the Taxonomic Editor will be
released in July 2010; smaller updates will be made available on the EDIT WP5 website.

1.1 About the Manual

Most of the manual has been produced whilst running the Taxonomic Editor on Microsoft Vista. If
you have a different operating system your screen may have a slightly different appearance to the
screen shots in the manual, however the actual work flows should not be affected. Where the work
flows may differ these have been detailed separately, however, the manual has not yet been
completed for use on Apple Mac systems.

This version of the manual for the Taxonomic Editor has been designed to provide an overview of
the design philosophies and capabilities of the Taxonomic Editor. It is not intended to be exhaustive,
but will allow you to make a basic taxonomic treatment. Additional sections will be made available
from the EDIT website http://dev.e-taxonomy.eu/trac/wiki/ or via the Help menu of the Taxonomic
Editor.

Within the work flow descriptions that follow the symbol (>) indicates a progression from one step in
a work flow to the next. Screen shots relate to the steps in the work flow given above the screen
shot, not below. Red arrows given in screen shots from one window/menu/box to another indicates
that the second will appear after carrying out the action in the first.

User Manual for Taxonomic Editor (Version 2.1.0.) 2
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2.0 Getting Started

This section tells you how to:
® Download and install the Taxonomic Editor for the first time.
e C(Create a desktop shortcut.
® |Install updates of previously installed features.
e Search for and install new features.
® Remove the Taxonomic Editor.
® Ensure that Unicode characters such as @ and & are visible.

2.1 Downloading the Taxonomic Editor

The Taxonomic Editor, as well as other EDIT Cyberplatform components, can be downloaded via the
Cybergate at http://dev.e-taxonomy.eu/platform/. There are no additional system features required
for the Taxonomic Editor to work.

1. Click EDIT Desktop Taxonomic Editor within the Cybergate. A description of the Taxonomic
Editor and further options will appear to the right of the Cybergate.
2. Click Download in the section on the right.

) EDIT Platform Cybergate - Mozilla Firefox
Fle Edit View History Bookmarks Tools Help

% -][Q

2 Most Visited P Getting Started . Latest Heac

|} EDIT Platform Cybergate x| [44 TaonomicEditorDownload - EDIT -... >

EDIT Desktop
Taxonomic Editor

The EDIT Desktop Taxonomic Editor
can be used to edit a wide array of
taxonomic data, including synonymy
lists, taxonomic trees, references, and
descriptive data. It uses an on-the-fly
parser to put free text into structured
fields, without forcing you to worry

about the dejgilsof the data model.
Hcmep:g mo |Developer

Map Images

Creatiop
Suondunsad

Map

BDTracker
ExpertsDB
Csso
Support

W Urirtied P < B @6 16

You will be taken to the Taxonomic Editor Download Site.
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Alternatively, you can access the download site directly by entering http://dev.e-
taxonomy.eu/trac/wiki/TaxonomicEditorDownload into the address bar of your browser.
3. Click the latest version of the Taxonomic Editor; the latest version will be specified.

Taxonomic Editor Download Site

The most recent version of the Taxonomic Editor will always be available here.
Downloads

Current stable release builds:

indows: EDITTaxonomicEditor_win32.x86_v2.1.0.20102003 10@

Older versions may be found in the = Archive

We strongly recommend that before starting, you take a look at the following to get a feel for the basic functionality of the Editor:

e =3 Tax Editor Manual - Platform Version 2.1

The following steps will differ slightly depending on whether you are using Mozilla Firefox or Internet
Explorer and the operating system you are using. If you are using Mozilla Firefox on Vista, you will be
taken straight to the “Save As” details pop-up box; go to Step 5. If you are using Internet Explorer or
Mozilla Firefox on an older operating system such as Windows XP, you will see a pop-up box the
same as or similar to the ones shown below; go to step 4.

4. Click the Save button or choose the Save option. Click the OK button if necessary. The “Save
As” details pop-up box will open; go to step 5.

Opening TaxonomicEditor-Version2.1.zip File Download

You h ch to
LIS nER I 2] Do you want to ocpen or save this file?
& TaxonomicEditor-Version2.1.zip

which is a: Compressed (zipped) Folder & Name: TaxonomicEditor-Version2. 1.zip
from: http:/jwp5.e-taxonomy.eu Type: WinRAR ZIP archive, 66.3MB
What should Firefox do with this file? From: wp5.e-taxonomy.eu
LRl oo e B ST T
SaveFile )

v| Al sk befi ing thi of fil
[] Do this automatically for files like this from now on. REEE ore opening this type of file

harm your computer. f you do net trust the source, do not open ar

l--"g\] While files from the Intemet can be useful, some files can potentially
.
OK Cancel R save this file. What s the rshk

Mozilla Firefox and Vista/Windows XP Internet Explorer and Vista/Windows XP

5. Choose a destination for the folder containing the Taxonomic Editor (Tip! You may have to
click a Browse Folders button as shown below in order to access your computer’s directory).
Make a note of the destination.

6. Enter a file name or use the default file name. Make a note of the file name.

7. “Save as type” should be Compressed (Zipped) Folder.
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Save As ﬁ

L) | . » LisaBanfield » Downloads - | 4,.| | Search o]

= =Rl | axonemicEditor-Version2.0-Preview.zip -

Save as type: ’Compred (zipped) Folder v]

| = Browse Folders|

\

@ Enter nakuf file to save to... =5
@CJ"‘ » My Computer » ~ %2 [ 5earen 2]
Wy Organize ~ ~ B New Folder )
Favarite Links Name [ Type TotolSizz  FreeSpace “Save As” details box:
B Documents glé‘;i?r‘c?ci}sts((c[;]:) ﬁ:ﬁfﬁiﬁ?ﬁim‘ choose a location and
Eil Recent Places <5 DVD RW Drive (E:) 58 bgbase (\superman) (R:
Deskto Removable Dik (F) 3 general (\\rbge.org.ukis
R oo | S Soeetidi| | name for the folder
i vore » i (choose a new name or
| Folders it — keep the default) and
I . oomicE ditor-Version2.0-Preview.zip Save.

« Compressed (zipped) Folder L

' Hide Folders ‘. Cancel

Tip! If you are using Mozilla Firefox and you do not see a pop-up box as shown above, your internet

options may not be set up to ask for confirmation on where to save files that you download. The
folder will automatically be saved to your desktop. If you wish to change this setting, see the
Troubleshooting instructions at the end of this section.

8. Click the Save button; a download progress bar will appear. The download may take a few
minutes.

' S T . &=
@ 72% of 1 file - Downloads b= | B S

ll TaxonomicEditor-Version2.0-Previewv.zip

q

20 seconds remaining — 48.2 of 66.2 MB (1.4 MB/sec)

You now have to extract the contents of the compressed folder; the exact method will depend on
whether you are using Mozilla Firefox or Internet Explorer (see Extracting the Contents of the
Compressed Folder (Internet Explorer) or Extracting the Contents of the Compressed Folder
(Mozilla Firefox) below).

Troubleshooting: Mozilla Firefox Settings
If your internet settings are set up to not ask you for confirmation as to where to save files and

folders that you are downloading, they will automatically be saved to your desktop. If you want to
change this setting open the Mozilla Firefox start page > click on the Tools menu on the toolbar at
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the top of the screen > click on Options. A new pop-up box will open. Click in the box to the right of
the text “Always ask me where to save files” and click OK:

fr ul
Cptions ﬁ |

= a2 )

Main Tabs Content  Applications Pﬁ;acy Security  Advanced

- Startup

When Firefox starts: [ Show my home page - ]

Home Page:  http://en-GB.start2 mozilla.com/firefox?client=firefox-a8irls= org.mozi

i Use Current Page ] ’ Use Bookmark ] [ﬂestore to Default ]

- Downloads

Show the Downloads window when downloading a file

] Close it when all downloads are finished

() Savefilesto Browse...

|< @ Always ask me where to save files
~

v
~ Add-ons
Change options for your add-ons Manage Add-ons...

[ oK ][ Cancel H Help ]

2.2  Extracting the Contents of the Compressed Folder (Internet Explorer)

Locate the compressed Taxonomic Editor folder in the destination in which you saved it.
2. Right-click the folder.
3. Click the Extract Files option.

| = TaxonomicEditor-Version2.0-Previens
Open

G >

Al gtorner
B Extract to TaxonomicEditor-Version2,0-Preview3)
Scan with Sophos Anti-Virus

Open With 3
[= Adobe Drive C54 »

Send To 3

Cut

Copy

Create Shortcut
Delete
Rename

Properties

A new pop-up box will open for you to choose the destination where the extracted folder
will be placed. The default destination will be the location of the compressed folder; if you
wish the extracted folder to be in the same place as the compressed folder there is no need
to change the destination.
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4. Select the destination and click the OK button. The folder will be extracted; this may take a
few minutes.

B Extraction path and options m

General | Advanced |
Destination path (wil be created if does not exist)
|C:\Dccuments and Settings*Sogotra®Deskiop Ii]

Update mode @ Deske

(¥) Bxtract and replace fies [} My Documents

(O Extract and update files a My Compter

() Fresh existing files only ‘ﬂ My Metwork Places

{h diptera lobs.db

Overwrite mode #-{3) My Music

8 fh ek e L. Epr deéggt[ilnaEF{S 0N

() Ovenarite without prompt g :\lorld tor{

() Skip existing files

() Rename automatically

Miscellaneous

Extract archives to subfolders

[ Keep broken files

[] Display files in Explarer
[ Save settings ]

[ ok [ canced |[ Hep ]

You should now create a Desktop shortcut for the Taxonomic Editor (see Creating a Desktop
Shortcut (Windows only) on page 8).

2.3  Extracting the Contents of the Compressed Folder (Mozilla Firefox)

If you have downloaded the Taxonomic Editor using Mozilla Firefox, when the download is complete
a pop-up box will open to inform you, as shown below.

1. Open the folder by double-clicking it in the pop-up box:

‘i Downloads E@g

TaxonomicEditor-Version2.0-Previewb.zip

66.2 MB — e-taxonomy.eu

Alternatively, locate the folder in the destination in which you chose to save it, and double-
click the .zip folder.

2. Click the Extract All Files button:
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%vlé v TaxonomicEditor-Version2.0-Previewb.zip » - | 3 | | Search 2|
e

‘ COrganize = e '} Extract all files

Name Type

| taxeditor File Falder

Favorite Links
I Documents

More »

4 L F

1 item

A new pop-up box will open for you to choose the destination where the extracted folder
will be placed. The default destination will be the location of the compressed folder; if you
wish the extracted folder to be in the same place as the compressed folder there is no need
to change the destination.

3. Select the folder destination using the Browse button or leave the default destination.

4. Ensure “Show extracted files when complete” is selected, and click the Extract button.

l\_:)l 4, Extract Compressed (Zipped) Folders

Select a Destination and Extract Files

Files will be extracted to this folder:
C\Users\Ibanfield\Desktop TaxonomicEditor-Version2.0-Previewh| Browse...

Show extracted files when@

( Extract )l Cancel

The contents of the compressed folder will be extracted; this may take a few minutes.

You should now create a desktop shortcut for the Taxonomic Editor (see Creating a Desktop
Shortcut (Windows only) on page 8).

2.4 Creating a Desktop Shortcut (Windows only)

It is recommended that you create a desktop shortcut to the file location of the TaxonomicEditor.exe
file as soon as you have downloaded and installed the Taxonomic Editor. You will then be able to
open the Taxonomic Editor using the shortcut instead of having to navigate to the .exe file location.
These instructions apply only to Windows systems.

1. Locate and open the extracted Taxonomic Editor folder in the destination in which you
chose to extract the folder (if you selected the “Show extracted files when complete” option
when extracting the folder it will automatically open).

2. Right-click the TaxonomicEditor.exe file; a drop-down menu will appear.

EDIT User Manual for Taxonomic Editor (Version 2.1.0.) 8
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3. Click the Send To option.
4. Click the Desktop (create shortcut) option.

=

Name Date modified Type Size
J cenfiguration 29/09/2009 16:49 File Folder
J plugins 29/09/2009 16:17 File Folder
J workspace 29/09/2009 16:49 File Folder

i 29,/09/2009 16:16 ECLIPSEPRODUCT... 1KB
= TaxonomicFditor.exe ) s 56 KB

@' Run as administrator
T-Zip »
Scan with Sophos Anti-Virus
/2009 16:16
B
/2009 13:25

Share...
Pin to Start Menu
Add to Quick Launch

Restore previous versions

( Send To D |

a0 (B Desktop (create shortcut)

Copy

( Docume
52 FaxRecipient
_J Mail Recipient
Delete i%  DVD RW Drive (E:)

=a

Create Shertcut

This will create a shortcut on your desktop that will automatically open the Taxonomic Editor:

Taxonomick
ditor.exe -
Shortcut

You can double-click this icon to open the Taxonomic Editor.

2.5 Opening the Taxonomic Editor

1. Double-click the Taxonomic Editor shortcut on your desktop (if you have not created a
shortcut it is recommended that you do so).

A security warning may open; this is a standard Windows security warning asking for confirmation
that you trust the source of the application.

2. If you have received a Security Warning pop-up, deselect the option “Always ask before
opening this file” — this will prevent this pop-up box from appearing every time you run the
Taxonomic Editor.

3. Click the Run button to continue opening the Taxonomic Editor.
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=
Open File - Security Warning Iﬁ

The publisher could not be verified. Are you sure you want to
run this software?

@ Mame: ..\taxeditor GOOD VERSION\TaxonomicEditor.exe
Publisher: Unknown Publisher
Type: Application
From: C\Users\lbanfield\Desktop'taxeditor GOOD VE...

@ask before opmi@

|@) This file does not have a valid digital signature that verifies its
)
k..

publisher. You should only run software from publishers you trust.
= How can | decide what software to un?

4. The Taxonomic Editor will load and open; this may take a minute or two the first time you
open the Taxonomic Editor.

5. The first time you run the Taxonomic Editor, you will be asked to choose a nomenclatural
code. Select the code you wish to use and click the OK button.

g
(2% Choose a nomenclatural code [é]

Welcome to the EDIT Taxonemic Editor,

Before proceeding, please choose a nemenclatural code, This code will be used to create
new names and to parse name text.

@ International Code of Botanical Momenclature (ICBM)

() International Code of Zoological Momenclature (ICZN)

If you hit "Cancel", the International Code of Betanical Nemenclature (ICBN) will be set
as your default nomenclatural code.

You can change the nomenclatural code at any time in the "Preferences” menu,

C x D canea |

A pop-up box will open confirming your choice of nomenclatural code.

You can change the nomenclatural code at any time in the “Preferences” (see The Preferences
Menu on page 31).

2.6 LogginglIn

Every time you open the Taxonomic Editor a log-in pop-up box will open. This feature is not yet
operational but will be in the next release of the Taxonomic Editor. It will allow changes to be
tracked if there will be multiple users of the underlying CDM data store and you need to track
changes, each user should log in under their own account. For now, skip the log-in by clicking the
Cancel button.
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[ ri!, Login ﬂ]
[Clos:

User Login

Username

Password

[ ok ) Gt D

2.7 Downloading and Installing Updates

Periodic updates of the Taxonomic Editor may be released. These can be usually be accessed via the
Help menu of the Taxonomic Editor, however this feature is not available in this version of the
Editor. Therefore to install updates you should remove your current version of the Editor as
described in section Removing the Taxonomic Editor on page 12 and reinstall as described in section

2.1t0 2.6 above.
2.8 Enabling Unicode Characters

The Taxonomic Editor uses the operating system's default font to display all the fields that store
specimen data. On a Macintosh, the system font is Unicode-compliant, so there is no

problem displaying specimen data that includes symbols such as ¢ and 4. On some, mainly older
Windows systems, this is unfortunately not the case. To ensure that all data will be visible on your
system, you may need to install a Unicode-compliant font on your Window’s system. If you are
experiencing this problem it can be resolved quite easily:

e Right-click on your Desktop.

e  (Click Properties in the drop-down menu > Click the Appearance tab > Click the Advanced
option. A new pop-up box will open.

e  Click the “Item” drop-down menu and select Message Box.

® Click the “Font” drop-down menu and select Arial Unicode MS.

The Unicode characters should now appear in the Taxonomic Editor.
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Advanced Appearance @

Windows and buttons: i
|‘|"u'"|ndow5 XFP style M b

Color scheme: Active Window

|5"‘"5" M Marmal Selected
Fort size: Effects... Window Text

B ] a==»] I

[ ok |[ Cancel | \ MessegeTeR o |

If you select a windows and buttons setting other than Windows Classic,
it will override the following settings, except in some older programs.

Item: Size! Color 1: Colar 2
| Message Box LD |- |-
Foni; Size: Color:
q_arial ricode s xl>  [v| (]
e —
Coc ) ow ]

If the Arial Unicode MS font is not shown as an option in the Font drop-down menu, and you are
using Microsoft Office 2000 or later, you can obtain the font from your Microsoft Office CD:
5. Insert the Office CD, and do a Custom Install.
6. Choose Add or Remove Features.
7. Click the (+) next to Office Tools > International Support > the Universal Font icon > Arial
Unicode MS font.
8. Follow the instructions 1-2 above.

2.9 Removing the Taxonomic Editor

To remove the Taxonomic Editor from your system, locate the folder in which the taxonomic
editor.exe file is stored on your system and simply delete the folder. If you cannot find the folder
and you are on a windows platform and have created a desktop shortcut to the Editor you can
determine the path to the folder by looking at the properties of the shortcut. Do this by right clicking
on the shortcut and selecting the properties option from the drop down menu. In the Shortcut tab

of the properties window look in the ‘Target field’ this will reveal the location of the taxonomic
editor.
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TaxonomicEditor.exe - Shortcut Properties Ei
Security Details Previous Versions
General Shorteut Compatibility
ﬁ TaxonomicEditor.exe - Shorteut
Target type: Application
| Target location: taweditor
Open file location 'q
:
B - \'l'a% banfield\Desktop‘taxeditor\ Taxonomic Editor ex
@ Run as administrator
7-Zip k Start in: C\Usefs\lbanﬁeld\Desktop\Iaxedrtor
Scan with Sophos Anti-Virus -
Pin to Start Menu horcut ey, | Norie
Add to Quick Launch Run: [Nomal window -
Restore previous versions Comment:
Send To L [ Open File Location ] [ Change lcon.... ] [ Advanced. .. ]
Cut 1
Copy l

Create Shortcut
Delete

Rename

[ ok J[ Gamed ][ oy

[ Properties -1

Navigate to the Taxonomic Editor folder and delete it by simply clicking once on the folder and
pressing the Delete button on the keyboard. A pop-up box will appear asking “do you really want to
delete this folder”; press Return on the keyboard to confirm.

TE——— ]
Delete Folder . m

Are you sure you want to move this felder to the Recycle Bin?

b
e N taxeditor
Date created: 05,/10,2009 11:25

You will also need to delete the cdm.Library folder where your local data is stored. The exact
location of this folder will depend on your computer system. In order to locate it, run a system
search as detailed for different operating systems:

2.9.1 Windows XP and older Systems

1. Click on the Windows Start button at the bottom left of your computer screen (on newer
systems you may only have an untitled Windows icon).

2. Select the Search button; a new pop-up box will appear.

3. Select Search All Files and Folders; a new pop-up box will appear.

4. Select the locations on your computer that you would like to search.
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5. Inthe search bar at the left hand side of the box enter “cdm.Library”.

6. Click the Run Search button.
The search will be carried out and the results will be shown in the main panel of the pop-up
box. The search will return a list of matching results. There should only be one folder called
“cdm.Library”.

7. Within the panel of the search box, click the cdm.Library folder once.

8. Press Delete on the keyboard.
A pop-up box will appear asking “do you really want to delete this folder”.

9. Press Enter on the keyboard to confirm.
The cdm.Library folder will be deleted.

If you cannot locate your cdm.Library folder using this method, please see the Microsoft help page
for Windows XP at:

http://support.microsoft.com/kb/308895

You can now delete the shortcut from your desktop: click on the shortcut, press the delete button
on the keyboard; a pop-up will ask you to confirm the deletion; click the OK button.

2.9.2 Windows Vista

1. Click on the Windows Start button at the bottom left of your computer screen. The Start
menu will open.

2. Click in the search bar at the bottom of the menu.

3. Enter “cdm.Library”:

L camLibrary "

78
': El ‘_:) »

Windows Start button Inbox - Micr...

A menu of matching search results will open.
4. Click the Search Everywhere option at the bottom of the search results menu.
A “Search results in indexed locations” window will open. At the left hand side is a list of
locations with matching folder names. One of these will be your user location on your PC.
5. Click the arrow icon at the left of your user directory to expand the menu. The cdm.Library
folder will be found in the menu.
Click the cdm.Library folder once and press the Delete button on the keyboard. A pop-up
box will appear asking “do you really want to delete this folder”.
6. Press Enter on the keyboard to confirm.
The cdm.Library folder will be deleted.

If you cannot locate your cdm.Library folder using this method, please see the Microsoft help page
for Windows Vista at:
http://windowshelp.microsoft.com/Windows/en-GB/help/ed53ade7-cfb8-425a-841d-
6a6aa6991dfel1033.mspx
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You can now delete the shortcut from your desktop: click on the shortcut, press the delete button
on the keyboard; a pop-up will ask you to confirm the deletion; click the OK button.

2.10 Creating Multiple Datasources

Multiple Datasources can be used to create separate databases or datasets within the Taxonomic
Editor. You may want to create a separate datasource for different users or for different taxonomic
treatments, allowing you to keep the information separate.

With the Taxonomic Editor installed and open on the machine:

1. Ensure that the Datasource panel is shown:

Window > Show View > Datasource

ri!, EDIT Taxonomic Editor
P —
File Edit Bulk Edit Window )elp

4 Preferences > o
= gum———— ) T —
Show View ] > Property Sheet
Legin Tabbed Properties
Tax

"

ﬂ!'; Taxonomic Tree Eg
Revision of Alyxia
Alyxia R Br. _zenomicles

Alyxia acuminata K. Schum. < Datasource >
Alyxia angustissima Merr. & Quisumb. W

Alyxia annamensis Pit, 1

Alyxia arfakensis Kaneh, & Hatus,
Il Alyxia augustifolia Ridl.

The Datasource panel will open at the bottom of the Taxonomic Editor window.

2. Press the right-click of the mouse with the cursor pointing within the Datasource panel; a
drop-down menu will appear.

3. Click New:
T Datasource 2 =g
C Mame Server Type Database Nomenclatural Code
T cdm local H2 Database cdm ICZN
LT diptera local H2 Database diptera ICZN
Connect
S
< New >
—
Edit
Delete

The “Create New Datasource” panel will appear.

4. Enter a name for the Datasource in the Datasource Name field:
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- — " e R EI
g,‘., Datasource Dialog Ll_lg‘:'

Create New Datasource

Datasource Name.( User & )

Database Type: [ -

< Back Next > Eoen

5. Click the arrow icon to the right of the Database Type field; a drop-down menu will appear.
6. Click the “H2 Database” option.

3% Datasource Dialog BRG]

Create Mew Datasource

Datasource Name: User A

N
Database Type: [ ( VI ’

MySQL |

< Back Net> || Finish

The drop-down menu will close.

7. Click Next.

3% Datasource Dialog o] (5

Create Mew Datasource

Datasource Name: User A

Database Type: H2 Database -

<Back C(_ Net> D Finch

The “Enter credentials for embedded H2 database” pop-up box will open.

8. Enter a Database name (for example the name of a user or a taxonomic group).
9. Select ICBN or ICZN as appropriate.
10. Click Finish.
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[ 3% Datasource Dialog - - E=NER

Enter credentials for embedded H2 database

Authentication

Database Mame( User 4| )

User Mame:

Password:

@ International Code of Botanical Momenclature (ICBN)

() International Code of Zoological Nemenclature (ICZN)

Ned>  Finish D Cancel |

Please Note: There is no need to input a user name or password. Although you can create a user
name and password if you wish, the enforcement of this function is not yet operational, therefore a
user will be able to edit any datasource without using the username and password.

The new Datasource will appear in the Datasource panel:

T Datasource 2 =8
C MName Senier T Databace Momenclatural Code &
e |
< T User & local H2 Database User A ICEN |=
T —— ;

= cdm Tocal By PR SE ok 1 cam ICZN

The process to create new datasources can be repeated as many times as desired.

2.11 Connecting to a Different Datasource

The open Datasource is indicated by an open folder icon in the Datasource panel:

T Datasource &3

Server Type Database Meomenclatural Code
( = User & local H2 Database User & ICEN
ser B local H2 Database User B ICEN

T cdm local H2 Database cdm ICZN
LT diptera local H2 Database diptera ICZN

To open a different Datasource for each tester:

1. Click the right mouse button with the cursor pointing to the Datasource you wish to select.
2. Click Connect.
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T Dataseurce 3
C Mame Server Type Database Nomenclatural Code
T=F User A local H2 Database User &4 ICBM
T UserB local H2 Database User B ICEN — —
< Connect >

T cdm local H2 Database cdm ICZN Nc~—  —
1T diptera local H2 Database diptera ICZM [z

Edit

Delete

The “Confirm Datasource Change” pop-up box will open.

;‘E, Confirm Datasource Change ﬁ

@% Do you really want to connect to this datasource?

k. Y

User B

P ——
d o« D concel
~

3. Click OK.
The Taxonomic Editor will restart with the selected Datasource open.

If you are opening a Datasource with a Nomenclatural Code that is different to the preferred
Nomenclatural Code that you selected when installing the Taxonomic Editor, you will receive a
warning:

The Datascurce that was just loaded has a different nomenclatural code than the one
I_IA stored in Preferences. The nomenclatural code was changed in the application.

4. Click OK; the warning will close and the Nomenclatural Code will be changed to match that
of the Datasource.
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3.0 Getting Started: Troubleshooting

3.1 Checking your version of Java Runtime Environment

If the Taxonomic Editor does not install successfully on your machine, it may be because you do not
have the latest version of Java Runtime Environment; the Editor will not work with any versions
previous to version 1.6 (released in December 2006). You can check what version of Java RE you
have on your machine in the following way:

Click the Start button on your PC > All Programs > Accessories > Command Prompt

A window will appear:

Em Command Prompt |ﬂ|—ﬂ_hj

Microzoft Windows [Uerzion 6.8_6662]
Copyright (¢ 2086 Microsoft Corporation. All rights reserved.

R

Type in the following command exactly as it is written (with a space following “Java” and a dash
before “version”):

Java —version

Press Enter. Information about your currently installed version of Java will appear, as shown in the
example below:

8 Command Prompt |ﬂlﬂ—hj

Microsoft Windows [Uersion 6.B_6HA2]
Copyright <c?> 2086 Microsoft Corporation. All rights reserved.

Zisvydava —version
java version "1.6.8_17"
JapadTMY 8F Buntime Fnoiwmonment (huild 1_6_“_1'?—]34)

Java HotSpot<(TM> Client UM C(huild 14.3-hP1,. mixed mode. sharing?
RN

The example shows that this computer has Java Runtime Environment 1.6.0_17 installed.
3.2 Updating your version of Java Runtime Environment

If you have a version of Java Runtime Environment earlier than 1.6.0, you will need to download and
install the latest version; please note that this is free. You can do this in the following way:
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In the search bar of your chosen search engine, input the following: www.java.com and press return.
The Java website will open. On the home page there will be a button to click for “Free Java
Download” (please note: the website was accessed in April 2010 and the appearance may change).

Java in Action  Downloads  Help Center

JAVA+YOU,
DOWNLOAD
TODAY!

— Free Java Download
» Whatis Java? » Dolhave Java? » Need Help? /

Click the “Free Java Download” button; the following screen will open: Note that the version
available for download is Version 6 update 20 (1.6.0_20).

Java in Action  Downloads  Help Center

Help Resources

Java for Windows - Firefox/Mozilla

Recommended Version 6 Update 20 (filesize: ~ 10 MB)
Windows 7, Vista, XP, 2000, 2003 and 2008 Server

» Remove Older Versions
= Other Java Versions

= Error Messages

= What is Java FAQ

b Free Java Download

Mot the right operating system? See all Java downloads here.

» Installation Instructions

System Requirements

+ Windows 7

» Vista If you are not using one of these
» Windows XP/2000 . lick h
R i s operating systems, click here

» Windows Server 2003

Intel and 100% compatible processors are supported. A Pentium 166MHz or faster processor with at
least 64MB of physical RAM is recommended. You will also need a minimum of 88MB of free disk space.
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Please note the system requirements listed for which the version downloaded from this page is
suitable. If your operating system is not listed, you can click the “See all Java downloads here” link
and choose the appropriate version from the list presented.

After clicking the download button, you will need to save the Java installer, which at the time of
writing is called “jxpiinstall” (if you do not know where the installer has been saved, you can locate it
by entering the name in your search bar). Locate and double-click the installer and follow the
instructions given to install Java Runtime Environment.
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4.0 Getting to Know the Taxonomic Editor

This section will teach you about:
® The different parts or panels of the Taxonomic Editor.
e The menus; their contents and functions.
e Standard commands and functions.

4.1 Parts of the Taxonomic Editor

This section gives a brief overview of the main sections of the Taxonomic Editor and some of the
terminology you will need to be familiar with.

The Taxonomic Editor has 4 main parts: (1) the Toolbar, (2) the Taxonomic Tree panel, (3) the
Freetext panel, and (4) the Properties Sheet. Additional panels showing (5) the User Manager and
(6) the Datasource are also available.

% EDIT Taxanomic Editor e
File Edit BulkEditor Window Help
3 El Search ~ v e 2|
[ Taxonomic Tree &2 = & ¥ = O|[[Z4 Enigmilichia Deeming &3 =5 =8|= Properties &2 A= ]
Brake, Irina, Milichiidae 3 s 7 . Property Value
Dipter.a. Lir.1.naeu5, 1758 m Enigmilichia Deeming, 1981 in o———
MI|IChIIC!E.E Sharp, 1899 Zool. J. Linn. Soc. Lond. 71: 160. Secundum Brake, Irina, Milichiidae

Madizinae 1981| Name Types
Desmometopa Loew, 1866 Doubtful? o
Lept?metopa Becker, 1903 ARrOlahoie
Madiza Fallén, 1810 vEn
Pseudodesmometopa Hennig, 1971 = -

Milichiinae 3 User Manager 3 8| Bxtensions
Enigmnilichia Deerning, 1981 admin
Eusiphona Coquillett, 1897 e

S : andreas
Milichia Meigen, 1830
Milichiella Giglio-Tos, 1835
Pholeomyia Bilimek, 1867
= =5

Ulia Becker, 1907 D i

new genus C MName Server Type Database

Newosms 1= Diptera_local local H2 Database diptera

new genue ne:Dtometopa 1 cdm local H2 Database cdm

Phyllomyzinae

Mot logged in

(1) The Toolbar contains a search bar to search within your data set and the Menus (see 3.2 The
Menus below for a list of menus available and their functions).

(2) The Taxonomic Tree panel provides a taxonomic, hierarchical representation of the relationships
between the taxa within your dataset.

(3) The Freetext panel is the main data entry area. There are 2 tabbed panels in this area: Name and
Descriptive. Only one panel is visible at a time; you can navigate between them using the tabs at
the bottom of the Freetext panel. The Descriptive tab shows descriptive data for the open
taxon, such as distribution information. The Names tab shows the nomenclatural information
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for the open taxon. If you are using the Bulk Editor facility, the bulk editor panel will open in
place of the Freetext panel. The Freetext panel is described in more detail in The Freetext Panel
on page 26.

The Properties Sheet panel displays the record details of the taxon that is open and selected in
the Freetext panel. Data can be edited directly in this panel.

The User Manager panel will be used to view, edit, create or delete user accounts in order to
track changes to your data, for example “Created By” and “Updated By”; it is not yet
operational.

The Datasource panel shows which datasource, or database, the Taxonomic Editor is currently
connected to. You can connect or delete connections to different datasources or create a new
datasource.

4.2 The Menus

,i!; EDIT Taxonomic Editor
| File Edit BulkEditor Window Help

File The File menu has the following options:
> New; for creating a new Taxon or Taxonomic Tree
> Close; > Close All; > Save; > Save All; these functions operate on the taxon or taxa
records that are open in the Freetext panel.
> Import; for importing data for an existing database or file.
> Export; for exporting data to a database or file.
> Exit; for closing the Taxonomic Editor.
> Recently opened records are listed at the bottom of the menu. Click on a taxon
name in this list to open the taxon in the Freetext panel.
Edit Bulk Editor Window Help
New 3 Taxon
Close Chrl+W Taxonomic Tree
Close Al Ctrl+ Shift+ W
Save Ctrl+5
Save All Ctrl+Shift+5
g2y Import...
7y  Export.
Exit
1 Alyxia acuminata K. Schum.
Edit > Undo; > Redo; these commands are currently operational only when using the

Bulk Editor (see below).
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Bulk Editor

Window

> Cut; > Copy; > Paste; > Delete; these commands apply to all panels of the
Taxonomic Editor apart from the Taxonomic Tree panel where only the Delete
function works.

ri!; EDIT Taxonomic Editor

| File Bulk Editor Window Help

Undo Ctrl+Z
Redo Ctrl+Y
of Cut Ctrl+X
i Copy Ctrl+C
5 Paste Ctrl+V

Delete Delete

The Bulk Editor is used to edit lists of:

> Names

> References

> Authors and Author Teams

See Bulk Editing on page 60 for further details.

ri!; EDIT Taxonomic Editor
[ File Edit [Bulk Editor| Window Help

Mame
Reference

Authers and Author Teams

> Preferences; for managing preferences (see Customising the Taxonomic Editor
on page 31).

> Show View; to open panels that have previously been closed (again, see
Customising the Taxonomic Editor on page 31).

> Login; to open the User login pop-up box. This feature is not yet functional.

ri"; EDIT Taxonomic Editor
| File Edit Bulk Editor [Window | Help

Preferences
Show View » Property Sheet
Login Tabbed Properties

Taxonomic Tree

Datasource

User Manager

> Download Help Manual (PDF); to download the latest version of the User Manual.
> Parser Help Website; to access documentation about the parser.

> Check for Updates; to access any available updates from the EDIT WP5 website.

> Install New Software; to install available software.

> About Taxonomic Editor; to access feature, plug-in and configuration details.

> About the EDIT Platform; to access information about the EDIT Cyberplatform.
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D EDIT Taxonomic Editor

File Edit Bulk Editor Window | Help
Download Help Manual (PDF)
Parser Help Website

Check for Updates
Install Mew Software...

About Taxenemic Editor

About the EDIT Platferm

4.3 General Behaviours and Navigation

4.3.1 Mouse and Keyboard Functions

In all sections of the Editor except the toolbar clicking the right mouse button will open up a context
menu containing a list of possible commands that can be performed on the data element the mouse
is pointing at. When no commands are available right-click will have no effect.

Most of the commands written in the manual are based on the user using the mouse. However, it is
also possible to use the keyboard for some functions. Notably, when pop-up boxes require
confirmation by selecting ‘OK’ or ‘Finish’, the default setting will be on the OK/Finish button,
therefore you can select OK/Finish by pressing Return on the keyboard as well as clicking the button
with the mouse.

Keyboard arrows can be used to navigate around the Toolbar area to find menus and make
selections. You must first click on one of the menus using the mouse, but can then use the arrows on
the keyboard to navigate and the Return/Enter key to make your selection.

4.3.2 Changing Panel Sizes

Each individual panel on the Taxonomic Editor can be resized using the mouse; as you point the
mouse arrow on the join between two panels a double-headed arrow will appear. Simply press and
hold the left mouse button and move the mouse until the panel is in the desired position and release
the left mouse button. The entire Taxonomic Editor can also be resized in this way. It also has the
standard minimise, maximise and exit buttons at the top right of the window.
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4.3.3 Opening and Closing Panels

Each individual panel can be minimised/maximised using the icons at the top right of the panel, or
closed using the ‘X’ icon on the tab bearing the name of each panel:

3 User Managgg, &2 = O Maximise

) N\

The panels can be reopened using the Show View menu (see The Show View Menu on page 37).

Close Minimise

4.3.4 Navigating between Panels

To change the active panel of the Taxonomic Editor you must navigate between them using the
mouse; clicking in a panel will activate it.

4.4 The Freetext Panel

This section describes how to work within the Freetext panel. The Freetext panel has two elements;
the Names tab and the Descriptive tab.

The Freetext > Name tab is where the nomenclatural information such as accepted name, authority
and nomenclatural reference as well as synonym information is displayed and updated.

The Freetext > Descriptive tab is where additional descriptive data such as distribution, common
names, conservation status, ecology etc is input, edited and displayed. See Adding Descriptive Data
to Taxon on page 72 for more details.

You can open either the Name or Descriptive tabs by clicking on the tabs at the bottom of the
Freetext panel:

2 Milichiinae 82 ™2 =g

m Milichiinae
HAS ORTHOGRAPHIC WARIANT MILICHINAE

(Name Descriptive )
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4.4.1 Activating Taxon Records in the Freetext Panel

Any taxon listed in the Taxonomic Tree panel can be opened in the Freetext panel by double-clicking
it in the Taxonomic Tree panel. This is the equivalent of opening a word processing file within the
database. The taxon record will be opened in the Freetext panel headed by a tab titled with the

taxon name:

Double-click here and the taxon opens here

in a new tab

(2% Taxonomic Tree 52

4 Brake Irina, Milichiidae

4 Diptera Linnaeus, 1758
4 Milichiidae Sharp, 1§99

4 Madizinae

. [sssrermeroprrtoem—+265
Leptometopa Becker, 1903
. Madiza Fallen, 18

- Pseudodesmometopa Hennig, 1971

= ‘& ¥ = O|[Z4 Leptometopa Becker, 1903 &3

=

m Leptometopa Becker, 1903 in Mitt. zool. Mus. Berl.
2: 188. 1903
HAS ORTHOGRAPHIC VARIANT HYPASPISTOMYA, HAS ORTHOGRA...

& Macrurus Lioy, 1864 in Atfi Ist. veneto Sci. (3) 9+10:
1313. 1863-1864, nom. illeg.

8

~

Please Note: when a taxon record is first activated in the Freetext panel the default display will be
the Names tab.

4.4.2 Searching for a Taxon Record

If you want to open a taxon record in the Freetext panel but you do not know its location in the
Taxonomic Tree, you can search for the taxon using the search bar at the top of the Taxonomic
Editor window

1. Click in the search bar.
Enter a search term — this can be the full taxon name or you can use the wildcard asterisk
(e.g. Des*, *halteralis, *halt* could all be used to search for Desmometopa halteralis).
Please note the search is case sensitive so you must use a capital letter where appropriate.
3. Press Return on the keyboard.

The search results will appear in a new tab in the Taxonomic Tree panel as shown below. Taxon
records with a black square icon can be double-clicked to open their records in the Freetext panel.
Those with green circles are synonym records; those which apply to more than one accepted taxon
record cannot yet be opened by double-clicking in the search results in this way. This problem will be
addressed in later versions of the Editor.
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Accepted Names: Can be selected — double-click
and the taxon will be activated in the Freetext >
Name panel

Synonyms: Those which apply to more than one
accepted name cannot be selected as above

Also in the search results are the types of taxa that you have included in your search. For example,

the search above included Taxa, Synonyms, Na

File Edit Bulk Editor Window Help

=

@,’; Taxcnomic Tree Lﬂ; Search: 'Madiza*' 2
Search String: Madiza®

Search for:

Status:

Taxa, Synonyms, Names (without taxa), Common Names

15 entities found

M Madiza Fallén, 1810

® Madiza albipennis Lamb, 1914

® Madiza annulitarsis Zetterstedt, 1848
B Madiza britannica Hennig, 1937

B Madiza eximia Papp, 1993

M Madiza glabra Fallén, 1820

® Madiza halteralis (1900)

® Madiza halteralis

® Madiza lacteipennis Hendel, 1913

® Madiza latipes (1830)

B Madiza nitens (Melander, 1913)

B Madiza pachymera Becker, 1908

® Madiza palpalia (1993) Wahlberg, 1548
® Madiza rufitarsis (1830)

® Madiza sordida Fallén, 1820

mes (without taxa) and Common Names:

L’,‘,’; Taxonomic Tree ﬂ,’; Search:

L B T Bl alin adt

‘Madiza® i3 =

=

Search for Taxa, Synonyms,

Mames (without taxa), Common Mames

Status: 15 entities found

Should you want to limit the search results to one or a sub-set of these options, you can do so by

selecting and/or deselecting your search criteria using the drop-down menu to the right of the

Search bar. Simply click the arrow icon to reveal the drop-down menu, and click on the available

criteria. If the criterion is included in searches there will be a tick icon to its left.

All criteria will be included in searches

Only (accepted) Taxa and Synonyms will
be included in searches

File Edit BulkEditor Window Help

i Madiza* Searc@ - - i ®
v | Taxa
v | Synonyms
v | Mames (without taxa)
v | Common Names

File Edit BulkEditor Window Help

i Madiza* Searcr@ - - %
v |Taxa
v |Synonyms

Mames (without taxa)

Commeon Names
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Tip! If your search results do not show any taxa but you know there should be matches within your

dataset, make sure that the search criteria are selected. If they are ALL deselected you searches will
be unsuccessful.

4.4.3 Navigating between Taxon Records

It is possible to open multiple taxon records so that there are several documents open in the
Freetext panel. Each taxon will be opened as a new document; each document can be accessed by
clicking on the appropriate tab at the top of the free text panel. A double-arrow icon will displayed

at the top right of the panel when there are more taxa open than are currently visible; the number
refers to the number of open taxon records.

The tabs of 2 taxon records are visible and there are 4 open taxon records that are not currently

displayed I\‘ |

L;‘:é Microsimus Aldrich ( L;‘:é Neophyllomyza Meland &2 "3 )= O

m Neophyllomyza Melander, 1913 in J1. N.Y. ent. Soc.
21: 242, 1913

HAS ORTHOGRAPHIC VARIANT MEOPHYLLOMYZZA, HAS ORTHOG...

@ Vichyia Villeneuve, 1920 in Bull. Soc. ent. Egypte 1920:
69. 1920

In order to view more tabs of taxon records you can expand the width of the Freetext panel using
the arrows that appear at the sides of the panel when you hover the mouse arrow over them (see
Panel Sizes on page 25). Also, clicking on the double-arrow icon will reveal a list of all the open taxon
records; those in bold are those for which the tabs are not current displayed:

{25 Borneomyia Brake 20 52 . [35 Neophyllomyza Meland s =
|

[;‘:a‘ Leptometopa Becker, 1903

m Borneomyia Brake, 2004 in Zootaxa 627: 2. .
Open taxa with tabs

© Genusnov. 1in Ent. scand. Suppl. 57: 13. 2000

[,11'; Microsimus Aldrich (JM), 1926

4".‘”1. hii

E};Bomeomyia Brake, 2004
E:Q‘Neophyllomyza Melander, 1913

not currently displayed

Taxa with currently
displayed tabs

You can click on any of the taxon records in the drop-down list to activate that record in the Freetext

panel.

4.4.4 Closing Taxon Records

You can close the activated taxon record by clicking on the Exit icon at the right of the tab:
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L~

g,*; Milichiinae g,*; Desmometopa Loew, 18 gl,i Leptometopa Eeck£ &3 ) il =0

m Leptometopa Becker, 1903 in Mitt. zool. Mus. Berl. 2: 188. 1903
HAS ORTHOGRAPHIC VARIANT HYPASPISTOMYA, HAS ORTHOGRAPHIC VARLAMT LEPTOP...
© Leptometopa Becker, 1903 in Mitt. zool. Mus. Berl. 2: 188. 1903
HAS ORTHOGRAPHIC VARIANT HYPASPISTOMYA, HAS ORTHOGRAPHIC VARIANT LEPT...

If you want to close a taxon record for which the tab for the record is visible, click on the tab to
activate the record and click the Exit icon as shown above.

When you have multiple taxon records open, you can close a taxon record that is not being
displayed without first having to navigate to it:

1. Point the mouse arrow at the double-arrow icon at the top of the Freetext panel; a drop-
down menu will appear.

Point the mouse arrow at the taxon in the drop-down list that you want to close.

Click the mouse so the taxon is highlighted.

Click the right-mouse button; the Close menu will appear.

Click Close.

The taxon record will close and the taxon name will disappear from the list.

vk wnN

gﬁ Leptometopa Becker, &2 Hﬁ Borneomyia Brake, 20 ( ! ) =

B Leptometopa Becker, 1903 in Mitt. zool. M| = :
i Microsimus Aldrich (JM), 1926

188. 1903 --
EDI Yy
HAS ORTHOGRAPHIC VARIANT HYPASPISTOMYA, HAS OR [E5 Neophyllomyza Melander, 1913

g!’; Borneomyia Brake, 2004
H,’; Leptometopa Becker, 1903
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5.0 Customising the Taxonomic Editor

This section tells you how to customise the Taxonomic Editor to suit your own needs. You can:
® Pick and choose which options will appear in drop-down boxes.
e (Create new options/data fields for several parts of the database such as taxon
descriptions.
® Choose which panels of the Taxonomic Editor are displayed.

5.1 The Preferences Menu

3%, EDIT Taxonomic Editor &

|Fi|e Edit Bulk Editor | Window | Help

Preferences

Show View 3

Login

Toolbar > Window > Preferences

5.1.1 Show/Hide Options of Drop-Down Menus

Some taxonomic and descriptive elements of the Properties Sheet have numerous options, as is the
nature of taxonomy, for example there are 19 options to describe the Distribution Status of a taxon.
You may find that you only need to use a sub-set of these options.

From the Preferences menu you can show or hide the options in certain drop-down boxes; this will
reduce navigation time required to find your desired option.

Options can be amended for the following fields:

> Description > Distribution Status; for example “introduced: cultivated”, “introduced:
naturalised”.
> Features; the features you would like to include in your taxon descriptions,
for example “common name”, “distribution” and “ecology”.
> Languages

> Taxonomic > Extension Types
> Marker Types
> Name Relationships; for example “misspelling for”, “basionym for”.
> Nomenclatural Code; ICBN or ICZN.
> Nomenclatural Status Type; for example “invalid”, “conserved”.
> Ranks; for example “cultivar”, “tribe”.
> Specimen Type Designation Status; for example “epitype”, “holotype”.

”n u

> Taxon Relationship Type; for example “overlaps”, “excludes”.
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To ame

nd the options that are shown in the drop-down boxes in the above data fields, open the

Preferences pop-up box (Toolbar > Window menu > Preferences option). The Preferences pop-up
will open.

1.

The Description and Taxonomic menus given above are located in the Taxonomic Editor

option in the menu. They can be accessed by expanding the Taxonomic Editor menu by
clicking on the arrow icon:

3,'!; Preferences |ﬂ|

type filter text Taxonomic Editor = - -
General

Install/Update ["] Show datasource selection dialog when editor starts.
axonomic Editor |

L

Description
Matching
Taxonomic

[ ok || concel |

2.

Click on the data field you would like to change from the menu on the left hand side of the
pop-up.

The existing options associated with the drop-down list for that data field will appear in the
main panel of the Preferences pop-up box. By default, all of the options will be selected. Use
the scroll bar to the right of the options list to navigate the list.

Ensure that all of the options you wish to appear in the drop-down box for that data field are
ticked, and all those you do not wish to appear are un-ticked. You will need to use the
mouse to do this.

You can use the Toggle button on the right-hand side of the box to select or deselect all of
the options in the list.

Click the Apply button > click the OK button to finish. The Preferences pop-up box will close
and you will be returned to Taxonomic Editor.
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,i!; Preferences

type filter text Distribution Status S v

Description Chaose which distribution states should be shown. -
Distribution Status ‘ =
Features introduced - ‘ S '
Languages introduced: adventitious (casual)

General introduced: cultivated

Install/Update introduced: doubtfully introduced (perhaps cultivated only)

Taxenomic

introduced: fermerly introduced
introduced: naturalized
introduced: presence questionable

ntroduced: reported in error

m

introduced: uncertain degree of naturalisation

m

native: doubtfully native
native: formerly native
native: presence guestionable

native: reported in error

SEOO0O0D00ORREEREEE

native

present

’Restore Defaults]( Apply J:
q oK } Cancel

-

5.1.2 Adding New Options to Drop-Down Menus

For some data fields in a Taxonomic Database there are so many possible options that it is
impractical to add all of them by default. Therefore there may be occasions where you wish to be
able to apply a value to a data field but do not have an option to do so within the drop-down list for
that data field, or there is no data field to accommodate the information you wish to enter.
To allow for this, some fields allow for new options to be added:

> Description > Features; the features you would like to include in your taxon descriptions,
for example “common name”, “distribution” and “ecology”.
You can add a new data field to the Descriptive panel found in the Freetext
panel.
>Taxonomic > Extension Types You can add a new data option to the Extension Type field
drop-down box found in the Properties Sheet.

1. Open the Preferences pop-up box (Toolbar > Window menu > Preferences option).
Navigate to the element you wish to change by expanding the Description or Taxonomic
menus found in the Taxonomic Editor menu:

type filter text

» General
+ Install/Update

P cnomic Editor
@lescription
Matching
GTaxonomic
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3. Click on the data field you would like to add to from the menu on the left hand side of the
pop-up. The existing options associated with the drop-down list for that data field will
appear in the main panel of the pop-up box. The example shown below is adding a new
feature or data field to the overall Description.

4. Click the New button.

5. Give the new data field a Label, an abbreviation if desired and a description if desired. Only
the data label is mandatory.

6. Click the Finish button.

3,"; Preferences |ﬂ!il
type filter text Features ) v v

De“'.'ptm” Cheese which features you would like to use for descriptive elements.

—_—l Abstract
Acknowledgments

General Additienal Publication

Install/Update Biology And Ecology
Taxonomic Citation

Commen Name

Conservation 'i';
Cultivation
Description
Diagnosis

Discussion
Distribution

Create new Feature

abel Phenclogy

]
N

Label Abbreviation

Flowering and fruiting times.|

Description

[ Finish ] ’ Cancel

Your new data option will be added to the drop-down box for the selected data field in the
Properties Sheet.

Please Note: The Remove option is not yet functional in this version of the Editor.

5.1.3 Editing Options of Drop-Down Menus

The Taxonomic Editor gives you the option to edit existing options of some drop-down boxes, as well
as selecting/deselecting and the creation of new options as described in the above sections. Editing
options allows you to change the name of the feature, abbreviation, and to add a description. This
may be useful if your datasets has several users and you wish to provide information so that the data
fields are used in a standardised way.

Options found in the following menus can be edited:
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Preferences > Description > Features for example “common name”, “distribution” and

“ecology”.

Preferences > Taxonomic > Extension Types

An example of how to edit a Feature of the Description menu is given below. For more information
on the Descriptive element of the Taxonomic Editor see section 9.0 Adding Descriptive Data to

Taxon on page 72.

1. Open the Preferences pop-up box (Toolbar > Window menu > Preferences option).
2. Navigate to the element you wish to change by expanding the Description or Taxonomic
menus found in the Taxonomic Editor menu:

type filter text

» General
+ Install/Update

P cnomic Editor
escription

= Matching

OTaxonomic

3. Click on the data field you would like to edit so that it is highlighted. The example shown
below is editing the Conservation feature.

ri!; Preferences

%

type filter text

General
Install/Update
Taxonomic Editor
Description
Distribution Status

Languages
Matching
Taxonomic

Features

[ Abstract
[ Acknowledgments
[T Additional Publication
[] Anatomy
[7] Biology And Ecology
[T Citation
Co
Conservation
[ Cultivation
[T Description
[T Diagnosis
[] Discussion
[7] Distribution
[[] Ecology
[ Etymology

[ N Py, 1y

»

m
i
m| |z
o ;
4

Remove

Toggle

m

OK

) [ cone

4. Click the Edit button:
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| g Preferences — - @Elg
[ type filter text | | Features v
General
Install/Update et i
Taxenemic Editor I helnoverl it B
Description [[] Additicnal Publication
Distribution Status [C] Anatomy ’
Features [] Biology &nd Ecology
Languages |:| Citation [
Matching [[] Common Name L
Taxonomic [] Conservation =M
[[] Cultivation L
[7] Description
[[] Diagnosis
[] Discussion
[] Distribution
7] Ecology =
[[] Etymology
[ I P VY = il
[ ok || conce |
Ll — I

The “Edit Feature” pop-up box will open.

5. Edit the feature as desired. An example is given below:

Edit Feature

Original Feature details

Label [conservation

Label Abbreviation

Description

Finish

Cancel

Edited Feature details

Edit Feature

Label Conservation Status

s

Label Abbreviation

IUCN Redlist categony
Description

[ Finish Cancel

J
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6. Click the Finish button:

(ED e

Edit Feature

Label Censervation Status

Label Abbreviation C5

IUCN Redlist categony
i Description

< i Finish l p Cancel

If you have edited the name of the Feature this will be immediately visible in the Features list:

3?, Preferences E@g
| type filter text | | Features Erep T W
General .
Install/Update [7] Biology And Ecology - -
Taxenomic Editor [C] Citation F
Description [[] Cemmon Name W 3
Distribution Status @sewation Status ) 1
Features [[] Cultivation
Languages [[] Deseription 3
Matching [C] Diagnosis C
Taxenomic [F] Discussion W
[ Pictribitinn M
ok || Ccancel

5.2 The Show View Menu

The five panels of the Taxonomic Editor can be closed independently by clicking on the (x) icon on
the right-hand side of the tab of each panel. For example:
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3% EDIT Taxonomic Editor . a - - . .
File Edit Bulk Editor Window Help

_ e - %
i Eﬁ‘] Search ~ =

ﬂ,’; Taxonomic Tr_. =] <;==»,‘> v =25 @ﬁ! Alyxia angustifolia Ri . =5

Revision of Alyxia
Alyxia m Alyxia angustifolia Ridl.

Alyxia acurninata K. Schurn,

Ay tifolia Ridl. :
il s @ Alyxia pachyphylla Merr.

= Alyxia pachyphylla Merr.

| Name: Descriptive-;

'llj User Manag ] = 0]

| admin

|

The Properties Sheet, Taxonomic Tree, Datasource and User Manager panels can be reopened by

clicking the panel name under the Show View menu.

1. Click the Windows menu in the Toolbar. A drop-down box will appear.
2. Move the mouse to the Show View option in the drop-down box.

ri"; EDIT Taxonomic Editor
| File Edit Bulk Edit(_[Window ] Delp

ﬁl’ grenres | /\
3 roperty Sheet
Legin Tabbed Properties

Taxonomic Tree
Datasource

User Manager

Toolbar > Window > Show View —

3. Click the panel option that you wish to open.

The panel will re-open in the Taxonomic Editor window.

Please Note: The Tabbed Properties option is for development purposes only and will be removed in
the next version of the Editor.

The Freetext panel is automatically re-activated after double-clicking on a taxon record in the
Taxonomic Tree panel.

Tip! If, when you select a panel in the Show View menu you still cannot see it in the Taxonomic
Editor window, it may have been minimised. Check at the bottom right of the window for minimised
panels:
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2% EDIT Taxonomic Editor | |l
File Edit BulkEditor Window Help

i
DW s (E Temorare)

: Search ~
5 » Be = B || E Properties 2 =

Diptera

Property

<
Taxenomic Tree: Diptera Mot logged in
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6.0 Creating and Building your Database

This section tells you how to:
e Understand the hierarchical system of a Taxonomic Editor database.
e Create and build a new taxonomic treatment database by creating taxonomic trees
and adding child taxa.

6.1 Note on terms and organisation within the Taxonomic Editor

The Taxonomic Editor allows for the input of data in a hierarchical way. Databases within the
Taxonomic Editor consist of taxonomic trees and taxa. Taxa can be independent or they can be
linked to other taxa in a parent/child relationship:

[ Taxonomic Tree e.g. Revision of Alyxia ] Name of Project, programme etc.

Name of Order, Family, Genus,
] species etc. This is a parent taxon

[ Child Taxon ] [ e.g. Alyxia

‘ Name of Order, Family, Genus,

Child Child e.g. Alyxia marginata species etc. This is a child taxon
Taxon Taxon to the taxon above, and a parent
taxon to the taxon below.

to the taxon below.

)

i ; S be attached at
Synonym [ e.g. Alyxia scabrida ] ynonyms can be attached at any

level in the hierarchy.

You can have an unlimited number of Taxonomic Trees within your database, with unlimited
numbers of taxa in each tree (however you may wish to store distinct taxonomic treatments in
separate Datasources; see Creating Multiple Datasources on page 15). Synonyms can be attached to

any taxon at any level.

6.2 Creating a New Taxonomic Tree

When using the Taxonomic Editor for the first time, you will need to create a new Taxonomic Tree.
This will create a root within the Taxonomic Tree panel to which all following taxa records will be
anchored; you may therefore want to give the taxonomic tree the name of a project, revision or
family for example. You can create a new Taxonomic Tree via the File menu:

1. Click the File menu in the Toolbar > move the mouse to the New option; a drop-down menu
will appear > Click the Taxonomic Tree option:
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ED EDIT Taxonomic Editor
Edit BulkEditor Window Help

| MNew » Taxon

[ Taxonomic Tree /)

Alternatively, you can access the New > Taxonomic Tree menu by clicking the right mouse
button with the mouse arrow pointing within the Taxonomic Tree panel:

ﬁTm(onomicTree b = q:p = ET
|
New » Taxon
Point the mouse arrow Edit q Taxonomic Tree
here and press the I’Ight _ Move Taxen (with Subtree)
mouse button; the drop- FIRN —
down menu will appear. i Export.
Z 1 Refresh Tree F5

2. Enter alabel for the Taxonomic Tree. This could be the name of a project or publication, for

example:

ri!; New Taxonomic Tree — @Elg

Taxonomic Tree

Create a new Taxonomic Tree.

e
Label: ( Revision of Alyxia| >
Reference:

Reference Detail

[ Finish ] I Cancel

You may enter reference details if you wish:

3. Click the Browse button to the right of the Reference field:
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ri!; New Taxonomic Tree . - @Eﬁ

Taxonomic Tree

Create a new Taxonomic Tree.

Label: Revision of Alyxia|
Reference: )
Reference Detail

[ Finish || cance |

A new pop-up box entitled “Choose a reference” will appear. The cursor will appear in the
search box by default. You can search here for a reference that you already have within your
database:

4. Type in the title of the reference; as you type, matching references from within your
database will be filtered and shown in the “Matching items” box beneath the search box:

ri!, Choose a reference =EACE X
Use * for wildcard, or 7 to see all entries -
d

Matching items:

C. r. hebd. Séanc. Acad. 5ci., Paris -
Calif. Vector Views (4
Califernia vector views

Can. Ent.

Can. ). Zool.

Canaceidae

Canadian Entomologist 7

[]Include authors in reference name

Click here to create a new reference,

C. r. hebd, Séanc. Acad. 5ci,, Paris

L [ ok || cancel |

If you are creating a new database or do not have the required reference already input, you
can choose to create a new reference by clicking the text at the bottom of the “Choose a
reference” box:
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5. Click on the arrow to the right of the Reference Type field; a drop-down list will appear:

3; Choose a reference E@g

Usze * for wildcard, or 7 to see all entries

Matching items:

[ Inclyde authors in reference name
Cli @- create a new reference.

The “Create reference” pop-up box will appear:

3"; Create reference ﬁ

Choose a reference type:

| Article -

Enter a title cache:

[ ok || Cconce

Choose a reference type from the drop-down menu:

gg Create reference ﬁ

Choose a reference type:

‘Arti.clre vl
Book |:|
Book Section

CD or DVD

Database ¥

[ ok || Ccancel

6. Scroll down the list; there are several methods for doing this:

a.

b
C.
d

Use the up and down arrows on your keyboard;

Use the mouse wheel if you have one;

Click and drag the position icon at the right hand side of the drop-down list;
Click the up and down arrows at the right hand side of the drop-down list.
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7.

9.

Click the desired reference type; the drop-down list will close.

i‘; Create reference lﬁ

Choose a reference type:

lJoumaI V]

Enter a title cache:

[ ok || cance

Alternatively to 6 and 7 above, type the first letter of the reference type you wish to select
whilst the reference type field is highlighted. Matching options will be shown each time you
press the initial letter. Continue until the desired option is shown in the reference type field.

Enter the details of the reference in the title cache field:

!i'; Create reference Iﬁ

Choose a reference type:

[Journal V]

Enter a title cache:

Middleton, D). 2000, Revision of Alyxia. Part 1: Asia and Malesia. Blumea 45 (1).

[ ok || conca |

Press the Return button on the keyboard or click the OK button; the “Create reference” box
will close and you will be returned to the “Choose a reference” box:

3,"; Choose a reference =RA0E X

Use * for wildcard, or 7 to see all entries -

Middleton, D.J. 2000, Revision of Alyxia. Part 1: Asia and Malesia. Blumea 45 (1),
Matching iterns:

Middleton, D.J. 2000, Revision of Alyxia. Part 1: Asia and Malesia. Blumea 45 (1).

[l Include authors in reference name

Click f1ere to create a new reference.

Middleton, D). 2000, Revision of Alyxia. Part 1: Asia and Malesia. Blurnea 45 (1)

OK ] l Cancel
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10. Press the Return button on the keyboard or click the OK button; the “Choose a reference”
box will be closed and you will be returned to the “New Taxonomic Tree” box.

If you wish to input reference details such as page numbers you can do so now:
11. Click in the Reference Detail field; the cursor will appear.

12. Type in the desired data.
13. Click Finish or press Return on the keyboard:

3"'; Mew Taxonomic Tree ' e @EI&J

Taxonomic Tree

Create a new Taxonomic Tree.

Label: Revision of Alyxia

Reference: Middleton, D.J. 2000, Revision of Alyxia. Part 1: Asia and Male

Reference Detd{] 1-145] )

)

The name of your new Taxonomic Tree will appear in the Taxonomic Tree panel:

File Edit Bulk Editer Window Help

=

£3 El Search =

[£} Taxonomic Tree &3 5%~ =0
Revision of Alyxia

It is possible to have more than one Taxonomic Tree in your database. Simply create a new
taxonomic tree using the method above. The trees will be listed in the Taxonomic Tree panel
simultaneously. Also note that the Taxonomic Tree names are displayed in a lighter colour than the
actual taxa names. You can use the arrows to the left of the taxonomic tree labels and the taxa to
show or hide the child taxon/taxa that are attached to that tree or taxon:

{2 Taxonomic Tree i3 5% ¥ =0
4 Brake, Inina, Milichiidae
Taxonomic Trees - Dipteralinnacus, 1736 ¢—u |
4 Revision of Alyxia = Taxa
Show/Hide children arrow Alyxia R Br 4~
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6.3 Adding Taxa to your Taxonomic Tree

There are two ways of adding taxa to your taxonomic tree. Using the right-click button (below) is

quicker and involves less steps.

6.3.1 Using the Right-Click Button

Once you have created your first Taxonomic Tree, you can add taxa to build up your database

according to your taxonomic treatment. You add taxa to your tree by creating a New Taxon that will

be linked to both the tree and a parent taxon if appropriate. The following description is the quickest

way to add a New Taxon to your tree:

Point the mouse arrow at the Taxonomic Tree or the intended parent taxon of your new taxon. As

you hover over the entries in the Taxonomic Tree panel they will become highlighted and a hand

icon will appear.

1. Click the right mouse button; a drop-down menu will appear.

2. Point the mouse at the “New” option; a drop-down menu will appear.

3. Click Taxon:

(&Y Tasonomic Tree i1 = =S =
4 Revision of Alyxia
Alyxia R, Br,

Mew r|C Taxon D

Edit Taxonomic Tree
In this example Alyxia will be Maove Taxon (with Subtree)
the parent taxon of the new g Import..
taxon, as indicated by the fact &y Export.
that it is highlighted. % Delete Delete

# | Refresh Tree F5

4. Enter the name of the taxon, including authorship if you wish.
5. Click the Finish button or press the Return button on the keyboard:
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ri'; New Taxon Node E@&J

Taxonomic Tree Revision of Alyxia Browse

Parent Taxon Node Alyxia R. Br.

D ause Existing Taxon Browse
—— e —
Taxon Mame Qﬂacuminata K. Scw Browse

Open Taxen in Editor

( Finish i Cancel

The new taxon record will appear in the Taxonomic Tree panel and is saved automatically:

{5 Taxonomic Tree &2 5&® ¥ =0
4 Revision of Alyxia
4 Abya BB

Alyxia acuminata K. Schum.

You can continue to add new taxa to the taxonomic tree in this way in order to build up your
taxonomic treatment. To create and manage synonyms and other relationships, see Managing
Taxonomic Relationships on page 65.

If you want to open the taxon record to view the parsing status of the information you have input
(see Parsing Status Feedback on page 52) or add to or edit the record (see the following section),
simply double-click the taxon name in the Taxonomic Tree panel.

6.3.2 Using the File > New Menu

As well as the above method, you can also access the New Taxon window via the File > New menu
on the toolbar. However, using this method you will need to manually input the Taxonomic Tree and
the Parent Taxon (if any) of the taxon that you are inputting.

1. Click on the File menu in the toolbar > New > Taxon:

ED EDIT Taxonomic Editor
Edit BulkEditor Window Help

—
New » C Taxon P

Close Ctrl+W Taxcnomic Tree

The New Taxon Node pop-up box will open.
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2. Click the Browse button to the right of the Taxonomic Tree field:

345 New Taxon Node Eni )

3

|| Taxonomic Tree

Parent Taxen Mode . Browse

[ Reuse Existing Taxon Browse

Taxon Mame | Browse

Open Taxon in Editor

Finish Cancel

The “Choose a taxonomic tree” pop-up box will open.
3. Enter a search term for the name of the Taxonomic Tree, for example the first letter of the
name. As you type, matching taxonomic trees will be shown in the “Matching items” field

below:
3% Choose a tamnﬂmi_ EEER)
Input a search term Use * for wildcard, or 7 to see all entries -
here i
Matching items:
Revision of Alyxia
As you type, s

matching items will
| Revision of Alyxia |

be shown here

[ ok || canca |

4. Click the name of the desired tree from the list in the “Matching items” field.
5. Click OK; the pop-up box will close and the name of the Taxonomic Tree will be shown in the
Taxonomic Tree field:
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I Taxonomic Tree |
Parent Taxon Node ' Browse
[ Reuse Existing Taxon [ | | Browse
Taxon MName Browse

Open Taxon in Editor

Finsh | | Cancel |

If appropriate, you can now choose a parent taxon node to attach the new taxon to in the
exact same way:

6. Click the Browse button to the right of the Parent Taxon Node field:

|i| Taxenomic Tree Revision of Alyxia | | Browse

Parent Taxon Node ._ Browse '

[F] Reuse Existing Taxon ' | | Browse

Taxon Name Browse

Open Taxon in Editor

Finsh | | Cancel

The “Choose a parent taxon node” pop-up box will open.

7. Enter a search term for the name of the parent taxon, for example the first letter of the
name. As you type, matching taxa from your selected Taxonomic Tree will be shown in the
“Matching items” field below:
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Input a search term
here

As you type,
matching items will
be shown here

35 Select parent E=E X

Use * for wildcard, or 7 to see all entries -

Matching iterms:

| Alyxia R, Br. sec. 777

| Alysia R. Br. sec. 777

ok || cancel

8. Click the name of the desired parent taxon from the list in the “Matching items” field.

9. Click OK; the

pop-up box will close and the name of the parent taxon will be shown in the

Parent Taxon Node field:

[T Taxon Nodc R =L ||

Ils| Taxonomic Tree Revision of Alyxia Browse

Parent Taxon Mode Alyxia R. Br. sec. 772

Taxon Name Browse

[F] Reuse Existing Taxon Browse

Open Taxon in Editor

Finish || Cancel

10. Click in the Taxon Name field.
11. Enter the name of the taxon, including authorship if you wish.
12. Click the Finish button or press the Return button on the keyboard:
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g,—'; New Taxon Node @M

Taxonomic Tree Revision of Alyxia
Parent Taxon Node Alyxia R. Br. Browse

[ Reuse Existing Taxon Browse
m— L ——
Taxon Mame Ivxia acuminata K. SchM Browse

Open Taxen in Editor

( Finish H Cancel

The new taxon record will appear in the Taxonomic Tree panel and is saved automatically:

{5 Taxonomic Tree &2 5&® ¥ =0

4 Revision of Alyxia

4 Alyxjg BB
< Algia acuminata K. SchD

You can continue new taxa to any node in the taxonomic tree in this way in order to build up your
taxonomic treatment. To create and manage synonyms and other relationships, see Managing
Taxonomic Relationships on page 65.

If you want to open the taxon record to view the parsing status of the information you have input
(see Parsing Status Feedback on page 52) or add to or edit the record (see the following section),
simply double-click the taxon name in the Taxonomic Tree panel.
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7.0 Editing your Taxa

This section tells you how to:
® Check the parsing status of your taxon records.
e Deal with parsing problems by editing basic fields in the Properties Sheet.
e Delete a taxon from your taxonomic treatment.
e Understand the bulk editor and how to use it to merge duplicate entries.
e Save you work.

7.1  Parsing Status Feedback

Parsing is the automatic separation of taxa data into its constituents parts, which is then stored
separately in the database. Editing your taxa records may therefore involve checking and editing the
parsing behaviour. The results of parsing your data will be displayed in the Properties Sheet.

The Taxonomic Editor will display the parsing status of a record when it is open in the Freetext
panel. If the taxon record you would like to check is not open, you can navigate and activate the
record as described in The Freetext Panel on page 26.

The parsing status is shown in the form of warning icons to the left of the taxon name and lines
beneath the taxon name in the Freetext panel. Hovering over a warning icon with the mouse arrow
will reveal a more detailed messages (the messages shown below are examples). The colours of the
icons are also indications of the type of warning. There are three possible parsing states:

7.1.1 Red warning icon = Parsing has been unsuccessful

(2% *New taxon 53 . ™ =8

LA

|Err0r: name not parsable or name-reference separation not possib|e| <+

Mame | Descriptive

The taxon name will be underlined in red and there will be the red warning sign E] to the left of the
taxon name. This warning sign indicates that the parser has not been able to separate the text string
into its constituent parts.

You can rectify this by editing the taxon information, if necessary, in the Properties Sheet (see
Dealing with Parsing Problems below).
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7.1.2 Orange warning icon = Parsing completed but checks are recommended

A >

2% *New taxon I3 3 =g

P Alyxia
Warning: check rank o A

Mame | Descriptive

The taxon name will be underlined in orange and there will be an orange warning sign i to the left
of the taxon name. This indicates that parsing has been successful, but that there is an element of
uncertainty and you may want to check that the parser has correctly inserted the separate elements
of your text string in the correct data fields. Hovering over the warning sign will give you details on
which element to check. In the example above the warning says to check that the Rank status has
been accurately determined. You have to check this in the Properties Sheet (see Dealing with
Parsing Problems below).

7.1.3 Black text only = No warning signal

A successful parsing action will be apparent from the lack of a warning sign and no underline
appearing beneath the taxon name in the Freetext panel. This indicates that the text string has been
separated into its constituent parts with confidence.

>

{25 Alyxia arfakensis Ka i3 2 =0

No warning signal ~ €——— ® Alyxia arfakensis Kaneh. & Hatus)

Mame | Descriptive

You may still check the parsing results in the Properties Sheet if you wish (see Dealing with Parsing
Problems below).

7.1.4 A Successfully Parsed Taxon Record

A successfully parsed taxon record is given in the following example. You should note the Parsing
Status = parsed, and the Uninomial, Specific Epithet and Authorship of the new taxon, shown in the
Name Cache menu, have been parsed to the correct locations.
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{2y Alyia arfakensis Ka 22 . 2 = B || E properties 2 ¥ =0

Property Value nd
m Alyxia arfakensis Kaneh. & Hatus)| 4+ Accepted Name
Parsing Status parsed
uuID Td31a363-3b0a-45b5-9091-29a31207b33d
MNomenclatural Code ICBN
< Rank SpeD
a Name Cache Alyxia arfakensis Kaneh. & Hatus. |
Editable Cache Alyxia arfakensis Kaneh. & Hatus. 3

Specific Epithet arfakensis
» Authorship Kaneh, 8 Hatus,

Reference Detail

MNomenclatural Status

Mame Relations

Annotations

Created 10-01-2009 10:36:44

P , N

Mame | Descriptive ' m | b

7.2  Dealing with Parsing Problems

If you have received a warning sign after entering a new taxon (see Parsing Status Feedback above)
or would like to check the parsing results you will need to check these data fields in the Properties
Sheet. This panel is an editable display of the data fields that are contained within the database. A
taxon record is displayed in the Properties Sheet when it has been activated in the Freetext panel. If
the taxon you need to edit is not yet open you can activate it by double-clicking the taxon record in
the Taxonomic Tree panel (see The Freetext Panel on page 26 for further details).

Initially you will need to expand the high level menus to reveal the relevant data fields and further
menus below them. This will include at least the Accepted Name menu, but you may also need to
expand the Name Cache menu depending on the information you are checking/editing.

The menus can be expanded or minimised using the arrow icons to the left of the appropriate menu.
These arrows are only activated when the mouse arrow is located within the Properties Sheet panel.

. ] Propertiss L.
Praperty
ccepbed Mame
Parsing Status
Ui
Homenclatural Code
Rank
@amt Cache
Editable Cache
Pratect Cache from o
Uninomaal

Autharship
Appended Phrase
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This version of the manual explains how to address problems with the basic data fields of Rank,
Uninomial and Specific Epithet. The Parsing Status field at the top of the Properties Sheet will
inform you of which field to check:

T Properties i3 ¥ =0
. ) Property Value
If you see this parsing status you + Accented Mam
should check the Uninomial and ﬁatus name not parsable or name-reference separation not@
e . . I L] B S T R e o o - o [ Tl R
SpelelC EplthEtflelds Memenclatural Cod ICZN
| Properties 2 ¥ =0
Property Value
. . 4 Acce Ll
IfyOU see this parsing status you Parsing Status check rank
should check the Rank field UuID T9685bb.2-103-4 cda-b417-d9
Momenclatural Code ICZN

Remember, if there continues to be a parsing problem after you have checked that the correct data
is stored in the correct data field, the record can remain as it is; you will not be forced to eliminate
the parsing problem before the data can be saved.

7.2.1 Rank

The Parsing Status of the field may ask you to check the Rank data field. If the rank is correct, there
is no need to take any action. If the rank is incorrect, you can change it using the drop-down menu:

1. Expand the Accepted Name menu using the arrow to the left of the menu.
Click within the Rank data field; the field will be activated and a drop-down menu arrow will
appear at the right of the field.

3. Click on the drop-down menu arrow; the data options for the Rank field will appear.

4. Navigate to the correct rank value using the bar at the right hand side of the menu to scroll
down if necessary.

5. Click the correct rank value; the drop-down menu will close and the selected rank will be
shown in the rank data field.

6. Save the record (see Saving your Work on page 62).
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Bl Properties 2

Property
Accepted Name
Parsing Status
U

seaenc|atural Ci
Editable Cach

Value

parsed

69572396-f49-40a9-9121-18cabdb23d]

ICEM
Species ‘ -

Infrageneric Taxon

Protect Cache Spec?es Group
i . Species Aggregate
Uninomial Subseries

Specific Epithi| Series
Authorship  |Subsection (Botany)
Appended Ph Section (Botany)

Momenclatural R Infragenus
| Subgenus =
Reference Detail | 1c

Momenclatural 5t{Suprageneric Taxon
Mame Relations |Infratribe
Annotations subtribe

Tribe
Created Supertribe
Created By Infrafamily
Secundum Subfamily
Farnily
Superfamily B

Note the many options in the Rank drop-down menu. This menu can be customised to show only
those ranks which you are likely to use. See Show/Hide Options of Drop-Down Menus on page 31
for further information.

7.2.2 Uninomial and Specific Epithet

In order for these fields to be visible, both the Accepted Name and Name Cache menus need to be
expanded using the arrows to the left of the data field name:

[ Properties [
Praperty
@({q}tﬂl Marme
Parsing Status
uum

Homenclatural Code
Rank

@lamt Cache
Editable Cache

Protect Cache from o
Uninomaal
Autharship
Appended Phrase

EDIT

e User Manual for Taxonomic Editor (Version 2.1.0.) 56

CY ) Distributed
Institute of

. . . Taxonomy




If these fields are incorrect, they can be edited simply:

1. Click in the relevant field; the field will become highlighted:

1 Properties &2 ¥ =0
Property Value |
Accepted Name
Parsing Status parsed
uuID b3fE949d- c0f c-486a-9f60-08266bb97 e
Nomenclatural Cod ICZN
Rank Species
Mame Cache Desmemetopa nudigena Sabrosky, 19

m

Editable Cache Desmemetopa nudigena Sabrosky, 19
Prote zzbe @
Uninomial
pecific Epithet nudigena
Authorship abrosky, 1983
Appended Phras

2. Make the correction.
3. Save the record (see Saving your Work on page 62).

7.3 Adding the Nomenclatural Status of a Name using the Properties Sheet

The Properties sheet of this version of the Taxonomic Editor will be changed significantly in the next
version of the Editor. Therefore the manual will not go into detail about how it works and how to
use it at this stage. However, it will give one example of how to enter data using the Properties

sheet; how to assign a status to a taxon name, for example, illegitimate, invalid, valid.

If the taxon you want to edit is not yet open you can activate it by double-clicking the taxon record in
the Taxonomic Tree panel (see The Freetext Panel on page 26 for further details).

1. Expand the Accepted Name menu by clicking the arrow icon to the left of the field label:

Tl Properties i3 =T =
Property Value
ccepted Mame
Parsing Status parsed
UuID d3ddB5ce-d76e-40f7-9316-1c93bb5 cdal2
Momenclatural Code ICBM
Rank Species
> Mame Alyxia angustifolia
- Momenclatural Reference
Reference Detail
Momenclatural Status

The Accepted Name menu will expand.

2. Click in the Nomenclatural Status field; the cursor will appear in the field and a drop-down
menu arrow will appear at the right of the field.
3. Click the drop-down menu arrow; the menu will appear:
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B Properties &3 T
Property Value
Accepted Mame
Parsing Status parsed
I d9ddB5cc-dT6e-40f7-9316-1c93bb5cdad2
Nomenclatural Code ICEN
Rank Species
Mame Alyxia angustifolia
MNomenclatural Reference
Reference Detail
Nomenclatural Status -
MName Relations
Annotations Alternative 3
Protologues Ambiguogs .
Combination Invalid
Created Confusum -

4. To navigate to and select the nomenclatural status you have several options:

a. Use the up and down arrows on the keyboard until the desired nomenclatural status
is highlighted and press the return button.

b. Navigate the menu by using the mouse to move the scroll bar to the right of the
menu up and down, or if your mouse has a wheel you can also use that. Click on the
desired nomenclatural status.

c. Type the first letter of the name of the nomenclatural status, for example, “V” for
“Valid”. The Editor will automatically jump to the first entry within the menu with
that first letter. Repeat pressing the letter until the desired nomenclatural status is
highlighted and press the return button.

Please Note: for this method to work you must enter the letter before any selection
has been made, i.e. when the Nomenclatural Status field is blank.

The drop-down menu will close, your selection will be shown in the Nomenclatural Status
field, and the text string in the Freetext panel will be updated:

5 *Alyxia angustifolia 2 ™1 = B | El Properties £2 T
i . Property Value
L A]}’X_‘la a.ngushfoh Accepted Name

Parsing Status parsed
UuID d9dd85cc-d76e-40f7-9316-1c93bb5cdad2
Momenclatural Code ICEM
Rank Species
Mame Alyxia angustifolia
Momenclatural Reference
Reference Detail
Momenclatural Status
Mame Relations

5. Save the record (see Saving your Work on page 62).
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7.4 Deleting a Taxon

There are two ways of deleting a taxon:

1. Click on the taxon in the Taxonomic Tree panel > press delete on the keyboard > go to step

3., or:
2. Point the mouse arrow at the taxon name in the Taxonomic Tree panel and click the right
mouse button; a drop-down menu will appear > click the Delete option.

[#% Taxonomic Tree &3 ===
4 Brake, Irina, Milichiidae
» Diptera Linnaeus, 1758
Revision

4 Revision of Alyxia
4 Alyxia

Alyxia acuminata

Alyxia arfakensi

New 3

Edit
Move Taxon (with Subtree)

g2y  Import..
iy Export...
/ —
¢ Delete Delete >
# ] Refresh Tree F5

A pop-up box will appear asking you for confirmation to delete the taxon from the
taxonomic view.

3. Click the OK button:

[ ,i'; Confirm Deletion ﬁ1

3 1 Are you sure you want to delete the selected taxa?

( oK ﬁ Cancel

The taxon will disappear from the Taxonomic Tree panel.

Please Note: You can delete a taxon even if it has child taxa attached to it; all the records will be
deleted. You cannot undo this action so you should be sure that this is what you want to do.
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7.5 Bulk Editing

7.5.1 About Bulk Editing

3,"; EDIT Taxonomic Editor
| File Edit [Bulk Editor | Window Help

Mame

Reference

Authors and Author Teams

Toolbar > Bulk Editor menu

The bulk editor allows multiple taxon records that share Names, References or Authors and Author
Teams data to be edited. These data types are not easily edited in the course of normal taxon
editing and are frequently referenced (shared) in several places within a dataset, therefore they are
edited in a separate location.

The Bulk Editor consists of a search field and a list editor. The list is populated when a search is
executed. The Property Sheet is used to display and edit details of the object which is currently
activated; changes made in the Property Sheet are reflected immediately in the list.

This version of the manual will explain how to edit the name of multiple taxa records.

7.5.2 Bulk Editing Names

In this example, we search for all the taxa within a Genus and change the Genus name.

1. Inthe Toolbar area, click on the Bulk Editor menu; a drop-down menu will appear.
2. Click the Name option.

ri!, EDIT Taxonomic Editor
| File Edit [Bulk Editor| Window _Help

< )
Mame

Reference

Authors and Author Teams

You will notice that a new tab has opened in the Freetext panel titled Names. The tab has a
search bar at the top and a blank space below which will display the results of your search.

3. Click in search box.

4. Enter a search term in the search box.
To find multiple variations for the same name it is best to use a shortened version of the
name with the ‘wildcard’ icon, an asterisk (*). The Taxonomic Editor will return all records
that match the initial letters you have input but with no restrictions on the following
characters (see the example below).
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Press Return on the keyboard or click on the Search button to run your search. A list of
matching records will appear beneath the search bar.

= Names 2 =0
Alyxia Search -
Alyxia R. Br. -

Blyxia acuminata E. Schum.
Alyxia angustifolia
Llyxia angustissima
Alyxia pachyphylla

You will also find that the Properties Sheet will display information regarding each entry in
the search results when you double-click its name within the list:

= Names &3 = B ||E Properties 2

Value

ia* Prope
Alyia Search = By

check rank
1616ceBe-cf21-4b9b-999c-933afEk
ICBM
Genus
Alyxia R, Br,

Alyxia

ELaiviinn ®.
Llyxia angustifolia

Llyxia angustiz=sima
Alyxia pachyphylla Memenclatural Reference
Reference Detail

In order to now change the genus name of all the taxa displayed in the Names tab, double-
click through the list and edit the name in the Properties Sheet to the right:

5. Double-click on a taxon from the list in the Names tab in the Freetext panel; the taxon
record will be activated in the Properties sheet as shown above.
6. Expand the Name menu by clicking the arrow icon to the left of the field label:

| Properties &3
Property Value
Parsing Status check rank
U 1616cele-cf21-4b3b-999c-933af8e35fb5
Nomenclatural Code ICEN
Rank Genus
ame Alyxia R, Br.
Editable Cache Alyxia R, Br.
Protect Cache from o no
Uninomial Alyxia
» Authorship R. Br.
Appended Phrase

7. Click in the Editable Cache field.
8. Edit the taxon name as desired, for example:
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1 Properties &3

Property Value
Parsing Status check rank
UuiD 1616cefe-cf21-4b9kb-999¢-933af8e35fb5
Momenclatural Code ICBN
Rank Genus
a4 MName Alyxia R. Br.

<_Editable Cache Pulassarium R, Br. >

Protect Cache from o no

Uninomial Alyxia
» Authorship R. Br.
Appended Phrase

9. Click the Save icon; the name will automatically be changed in the Names tab in the Freetext
panel and in the Taxonomic Tree:

{2 Taxonomic Tree 22 =5 T T O[5 Names 2 —a
Revision of Alyxia -
¥ Alyxia®
Apocynacese - Search ~
Pulassarium R. Br. Pulassarium R. Br
Alyaa acuminata K. Schum. nlyxia ac —SC L.
Alyxia angustifolia Zlyxia angustifolia

Alyxia angustissima
Blyxia pachyphylla

You can now move down the list in the Names tab and edit all the names as described above.
7.6  Saving your Work

Generally there are four ways in which you can save any changes to your data:

a. By clicking on the save icon in the toolbar:

File Edit Bulk Editor Window Help

F@ Search =

b. Via the File menu:
—_
File | Edit Bulk Editor Window Help
Mew 3
Close Chrl+W
Close Al Ctrl+ Shift+ W
(@ Save ) Ctrl+5
C. By pressing the “Ctrl” and “S” button on the keyboard simultaneously.
d. Via the right mouse button:
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Point the mouse button 7 =Alyxia R. Br. &3

within the Freetext panel ®» Alyxia R. Br.|

. . New 3
> click the right hand
. > Change Accepted Taxen to Synonym
mouse button > click
E‘ﬁ‘] Save Ctrl+5

Save.

Please Note: If you have multiple taxon records with unsaved changes these methods will only save
changes in the currently activated record i.e. the record that is open in the Freetext panel. To save
all unsaved changes in multiple records you need to select the Save All option found under the File
menu:

Click on the File menu in the Toolbar; the File drop-down menu will appear > Click on Save All.

;.";.EEIT Taxonomic Editor
_— - - e &
I\l File )Edit Bulk Editor Window Help
\'/New N
Close Ctrl+W
Close All Ctrl+Shift+W
[5] Ssave Ctrl+S
I save Al Ctrl+Shift=5

Any record that has been edited without being saved will be flagged with an asterisk in the Freetext
panel to the left of the taxon name in the tab label:

An asterisk indicates unsaved changes
g,i Milichiinae hyllomyza Melan ometopa Becker, &% = =B

-

m Leptometopa Becker, 1903 in Mitt. zool. Mus. Berl. 2: 188. 1003

HAS ORTHOGRAPHIC VARIANT HYPASPISTOMYA, HAS ORTHOGRAPHIC VARIANT LEPT...

@ Macrurus Lioy, 1864 in Atti Ist. veneto Sci. (3) 9+10: 1313. 1863-1864,
nom. illeg.

LATER HOMOMNYM FOR MACRURUS BLOCH, 1780
@ Hypaspistomyia Hendel, 1907 in Wien. ent. Ztg. 26: 240. 1907 -

Name | Descriptive

If you attempt to try to close an edited taxon record without saving your changes the Taxonomic
Editor will give you a warning:

[ ri!, Save Resource —— @

[ v || Mo |[ Cancel
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Any changes to text in the Freetext panel will not appear in the Taxonomic Tree panel until the
changes have been saved as above. Alternatively, you can refresh the taxonomic tree by right-
clicking anywhere in the Taxonomic Tree panel and selecting Refresh Tree:

Point the mouse arrow anywhere within the Taxonomic Tree panel > Click the right mouse button; a
drop-down menu will appear > Click the Refresh Tree option.

_ _

File Edit Bulk Editor Window Help

< x "
W Search ~ @ =l T T
|#% Taxonomic Tree &1 5%~ =0

4 Brake, Irina, Milichiidae
a Diptera Linnaeus, 1758
a Milichiidae Sharp, 1899
> Madizinae

> new genus — R
> Phyllomyzinae
Revision Edit
> Revision of Hllqjlcght-CIICk Move Taxon (with Subtree)

g2y Import..

kﬂ Export...

p——— e —

2| Refresh Tree F5
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8.0 Managing Taxonomic Relationships

This section tells you how to:
® Add heterotypic and homotypic synonyms to taxa.
e Save, delete and edit synonyms.
® (Change a synonym to an accepted name.
® Change the position of taxa within a taxonomic tree.

8.1 Adding a Heterotypic Synonym
There is a quick and easy way of attaching synonyms to a taxon record:

1. Inthe Taxonomic Tree panel, double-click the taxon to which you want to attach a synonym;
this will open the record in the Freetext panel if it is not already open (see Activating Taxon
Records on page 27 for more information).

2. Click in the Freetext panel to the right of any text already entered.

3. Press Return on the keyboard.

Another text box will appear in the Freetext panel, below that of the root taxon/accepted name for
which you are entering a synonym. You will notice the standard taxonomic synonym indicator (=) at
the left hand side of the new text box within a green circle:

[Z% Milichiidae Sharp, 1 || 2% *Phyllomyzinae £2 . =0

m Phyllomyzinae

If the synonym text box was opened in error, point the mouse arrow into the synonym text box and
click the right mouse button; a drop-down menu will open > click on the Delete option:

[Z2 Milichiidae Sharp, 1 |[&% *Phyllomyzinae 3 . ™3 =0
m Phyllomyzinae

e \L
Mew 3
Right-click ,

Change To

| —
< ¥ Delete Delete 1D
T — —1

Set as Original Combination for Group

Swap Synonym With Accepted

[] Save Ctrl+5

4. Enter the name of the synonym.
5. Save the synonym (see Saving Synonyms below).
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8.2 Adding a Homotypic Synonym

By default, a carriage return from a taxon record in the Freetext panel will create a new text box for
a heterotypic synonym, as detailed above. Homotypic synonyms can be added using a drop-down
menu:

1. Point the mouse arrow into the text box for the taxon to which you are attaching a

homotypic synonym and click the right mouse button; a drop-down menu will appear.
2. Point the mouse at the New option at the top of the menu; a new menu will appear.
3. Click on the Homotypic Synonym option:

{12 Madizinae 71 . 2 =0

m Madizinae| = Tt ) \.J Child Taxon

Change Accepted Taxon to Synonym Heterobuai

Homotypic Synonym

|:‘5‘] Save Ctrl+5

Concept Relation ]

Misapplication

Another text box will appear in the Freetext panel, below that of the root taxon/accepted
name for which you are entering a synonym. You will notice the homotypic synonym icon of
(=) inside a blue circle:

»,

{22 *Madizinae &1 2 =0

m Madizinae

6. Enter the name of the synonym.

7. Save the synonym (see Saving Synonyms below).
8.3  Saving Synonyms
You can save synonym records by either:
1. Pressing Control and S together on the keyboard, or by:

2. Pointing the mouse arrow into the synonym text box and click the right mouse button; a
drop-down menu will open > click on the Save option:
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{2 Milichiidae Sharp, 1 ﬂ;l;, *Phyllomyzinae 52 - 73 =8

m Phyllomyzinae

Borneomyi
e yial e N
RIght-C/ICk A Change Te 3
¥  Delete Delete

Set as Original Combination for Group
Swap Synonym With Accepted

pm— T —
] Save Ctrl+5
—— E——

After you have saved the synonym name will appear in the Taxonomic Tree panel beneath
the accepted name with a synonym symbol:

(&Y Taxonomic Tree 32 =5& ¥ =0
Brake, Irina, Milichiidae -
Diptera Linnaeus, 1758
Milichiidae Sharp, 1899
Madizinae

New genus
new genus n

¢ reruge o Lt atona
Phyllemyzinae
= Berneomyia

Note that synonyms are shown in the Taxonomic Tree panel in a lighter font than accepted

m

names, and the synonym symbol (=) applies to all types of synonyms.
8.4 Editing Synonyms

A synonym name is parsed in exactly the same way as a root or child taxon. However, in the
Properties Sheet panel you will see that Synonym Name is seen at the top, rather than Accepted
Name. The details of a synonym name can be expanded and edited in the Properties Sheet panel in
the same was as a child taxon (see Editing your Taxa on page 52).

(25, =alyxia augustifolia 52 . 72 = O || E properties 52 =
Value
m Alyxia angustifolia Ridl.
parsed
. 415d7ac0-f022-4020-82
9 Alyxia pachyphylla Merr.l Nomendatural Code ICBN
Rank Species
1=l Mame Cache Alyxia pachyphylla Merr
Editable Cache Alyxia pachyphylla Merr
Protect Cache from ov no
Uninomial Alyxia
Spedfic Epithet pachyphylla
Authorship Merr.
Appended Phrase
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8.5 Deleting a Synonym

1. The accepted name to which the synonym you wish to delete has to be open in the Freetext
panel (see The Freetext Panel on page 26 to learn how to search for and open a taxon
record).

2. When the record is open, point the mouse arrow into the text box of the synonym you want
to delete within the Freetext panel.

3. Click the right mouse button; a drop-down menu will appear.

4. Click the delete option.

{25 *Alia angustifolia £2 . ™% =g

m Alyxia angustifolia Ridl.

@ Alyxia pachyphylla Merr.|

New »
ngh t-click \ Change To »

Set as Basionym for Group
Swap Synonym With Accepted

[&] save Ctrl+5

5. Save your changes (see Saving your Work on page 62).
8.6 Changing a Synonym to an Accepted Name

1. The accepted name taxon record which has the synonym attached to it that you wish to
change to an accepted name has to be open in the Freetext panel (see The Freetext Panel
on page 26 to learn how to search for and open a taxon record).

2. Right-click anywhere within the text box of the synonym in the Freetext panel; a drop-down
menu will appear.

3. Point the mouse arrow over the Change To option; a new drop-down menu will appear.

4. Click the Accepted Name option:
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|2} Boreomyia acanthoph &% . ™ =g

® Borneomyia acanthophora Brake,
2004 in Zootaxa 627: 7. 2004

ORIGINAL COMBINATION FOR GENUS NOV.15P.1 ...

© Genusnov. 15p. 1 (2004) in Ent. scand.

Suppl. 57: 13. 2000 ~— MNew N |
>
15 NEW COMBINATION FOR BORNEOMYIA ACA.. Change To , Accepted Taxan
¥ Delete Delete Concept Relation 3
Misapplication

Set as Original Combination for Group
Swap Synonym With Accepted

[5] save Ctrl+5S

5. Save your changes (see Saving Synonyms on page 66 above); your changes will appear in the
Taxonomic Tree panel:

Borneornyia Brake, 2004
Borneomyia acanthophora Brake, 2004
I Genus nov. 1 sp. 1 (2004) I

8.7 Changing an Accepted Name to a Synonym

1. The accepted name taxon record that you wish to change to a synonym has to be open in
the Freetext panel (see The Freetext Panel on page 26 to learn how to search for and open
a taxon record).

2. Right-click anywhere within the text box of the taxon record in the Freetext panel; a drop-
down menu will appear.

3. Click on the option “Change Accepted Taxon to a Synonym”:

1 Genusnow.1sp.1( 82 . ™4 =0

® Genus nov. 1 sp. 1 (2004) in Ent.

Right-click
scand. Suppl. 57: 13. 2000]|

Newy

Change Accepted Taxon to Synonym

IS NEW COMBINATION FOR BORMECMYLA A

The “Choose the accepted taxon” pop-up box will open.

4. Enter the name of the accepted name that you wish to attach the synonym to in the search
bar at the top of the pop-up box; as you type, matching entries will be filtered automatically
and will be shown in the “Matching items” box beneath the search bar:
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Type the name of the
accepted taxon here

Matching entries will
be shown here

3% Choose the accepted taxon =HECAL X

Use * for wildcard, or ¥ to see all entries -

Boil
Matching items:

Boerneomyia acanthophora Brake, 2004 sec. Brake, Irina, Milichiidae

Berneomyia Brake, 2004 sec. Brake, Irina, Milichiidae

Borneomyia acanthophora Brake, 2004 sec. Brake, Irina, Milichiidae

[ ok || cancel

5. Select the desired accepted name by either:
a. Point the mouse cursor to the desired accepted name and clicking the left mouse

button twice; or
b. Point the mouse cursor to the desired accepted name; click the left mouse button
once and then click the OK button.

The “Choose the accepted taxon” pop-up box will close and the record that has been edited

will be shown as a synonym in the Freetext panel and the Taxonomic Tree panel:

3

4

(% Taxonomic Tree I3 = 6. ¥ = 0|5 Bomeomyia acanthoph 3 2 =4O
a Diptera Linnaeus, 1758 -
4 Milichiidae Sharp, 1899 i m Borneomyia acanthophora Brake,
4 Madizinae 2004 in Zootaxa 627: 7. 2004

» Desmometopa Loew, 1866
- Madiza Fallén, 1810
» Pseudodesmometopa Hennig, 1971

ORIGINAL COMBINATION FOR GENUS NOV. 1 SP....

@ Genusnov. 15p. 1 (2004) in Ent. scand.

new genus
Phyllemyzinae Suppl. 57: 13. 2000
= Borneomyia E IS NEW COMBINATIOMN FOR BORMNEOMYIA AC...

—a _Borneomyia Brake 2004
a Borneomyia acanthophora Brake, 2004

Mame | Descriptive

= Genus nov. 1 sp. 1 (2004)

» Costalima Sabrosky, 1953
- Micresimus Aldrich, 1926

The change is automatically saved.

8.8 Moving

the Position of Taxa within a Taxonomic Tree

If a taxonomic treatment has changed and you need to update your taxonomic tree to reflect this,

this can be done easily via the Move Taxon (with Subtree) function. This function allows you to

move a taxon with any associated synonyms and child taxa.

1. Pointthe

mouse arrow at the taxon name which you want to change within the Taxonomic

Tree panel.

2. Click the right mouse button; a drop-down menu will appear.
3. Click the Move Taxon (with Subtree) option:
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f@,’; Taxonomic Tree &3 BEE& =0
» Brake, Irina, Milichiidae
Revisi
4 Revision of Alyxia
a Alyxia
a4 Alyxia acuminata
qﬂia ansustissima Merr, & Quisuhg'
Alyxia annamensis Pit. MNew
Alyxia arfakensis Kaneh & Hatus.

=1on

Edit

,' .
Ll Mowve Taxen (with Subtree)

g2y Import..
&y  Export.
K  Delete Delete

&) Refresh Tree F5

4. The “Choose new parent” pop-up box will open. In the text box at the top of the box, enter a
term to search for the parent taxon to which you would like to move the child to.
As you type the Taxonomic Editor will automatically search for matching taxon names. You
can also use (*) to search using part of the name, or (?) to see all entries. A list will appear
with matching taxon names:

A% Choose new parent = @

Use * for wildcard, or 7 to see all entries  w

A
Matching items:
Alyxia acuminata K. Schum. sec. Revision of
Alyxia angustifolia Ridl. sec. Revision of Aly»
Alyxia sec. Revision of Alyxia
[£] I | 3]
[ CK l [ Cancel ]

5. Click on the name of the desired parent taxon.

6. Click the OK button or press Return on the keyboard. Alternatively, simply double-click the
name of the desired parent taxon.

7. The location of the selected child taxon will be moved within the Taxonomic Tree and will be

saved automatically:

% Taxonomic Tree & 5%&® ¥ =0

> Brake, Irina, Milichiidae

4 Revision of Alyxia
a Alyxia

Alyxia g inata
< Alﬁia angustissima Merr, 8 QuisumD

Alyxia annamensis Pit.
Alyxia arfakensis Kaneh & Hatus.
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9.0 Adding Descriptive Data to Taxon Record

There is a variety of types of descriptive data that can be added to a taxon (shown below). If you do
not need to use all of these kinds of data you can remove the available descriptive data types via the
Preferences menu as explained in Show/Hide Options of Drop-Down Menus on page 31. Due to
the variety of data types available, examples will be given here rather than instructions specific to
every data type.

Please Note: The Descriptive Data element is under construction and there may be some changes to
later versions of the Taxonomic Editor.

9.1 Types of Descriptive Data

The descriptive data tab allows you to attach descriptive data to each taxon within your taxonomic
tree. The following types of data can be included:

Abstract Discussion Observation
Acknowledgements Distribution Occurrence
Additional Publication Ecology Pathogen Agent
Anatomy Etymology Phenology
Biology and Ecology Host Plant Protologue
Citation Individuals Association Specimen
Common Name Introduction Synopsis
Conservation Key Unknown Feature Type
Cultivation Materials Examined Uses
Description Materials Methods

Diagnosis Multiple

The format of the types of descriptive data varies; for some the data is input as freetext but for
others data must be chosen from options given in drop-down menus.

Please Note: The options given to you in the drop-down menus can be customised using the
Preferences menu (see Show/Hide Options of Drop-Down Menus on page 31).

9.2 Opening the Descriptive Tab for a Taxon

The descriptive data tab is located in the Freetext panel. A taxon has to be included in the
Taxonomic Tree panel and has to be activated within the Freetext panel before descriptive data can
be added to that taxon.

Any taxon listed in the Taxonomic Tree panel can be opened in the Freetext panel by double-clicking
it in the Taxonomic Tree panel. This is the equivalent of opening a word processing file within the
database. The taxon record will be opened in the Freetext panel headed by a tab titled with the
taxon name:
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Double-click here and the taxon opens here _ in a new tab

{24 Taxonomic Tree E@l & ¥ =0 ﬁ ﬂ“ﬁi an ” I ﬁ H ii —

4 Revision of Alyxil

4 Alyxia R. Br. m Alyxia angustifolia Ridl)

Alyxia annamensis

Alyxia annamensis Pit.
Alyxia balansae Pit.

”~ ~
Name] [Bscriptive |

The default tab open will be the Name tab

To access the Descriptive data tab you need to click the “Descriptive” tab at the bottom of the
Freetext panel:

% EDIT Taxonomi
—

File Edit BulkEditor Window Help

rﬁ : Search - 2 v v %

B4 Toonomic Tre 5| % 7~ O | Y O nyvo toocPr. | =

Revision of Alyxia
Alyxia R. Br. m Alyxia angustifolia RidL

= Pulassarium

Alyxia acuminata K. Schum.

Alyxia angustifolia Ridl,

Alyxia angustissima Merr. & Quisumb.
Alyxia annamensis

Alyxia annamensis Pit,

Alyxia balansae Pit.

I Nam

N————

The Descriptive data tab will open:
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] *Alydia angustifolia Ridl. 5% | O] Alyxia balansae Pit. =

Descriptions

Description Tree display&ll collapseAll

Mame | Descri ptiveJ

9.3 Adding a Description Tree to a Taxon

The taxon must first be activated in the Freetext panel; see the section above. To access the
Descriptions menu do the following:

1. Point the mouse cursor in the “Description Tree” box.
2. Press the right-hand mouse button; a menu will appear:

[T Alyxia angustissima Merr, & Quisumb, 2 =

Descriptions

Description Tree displayAll collapseall

Press the right-hand T—

mouse button with the > Menu appears —» New Image Gallery

cursor pointing here % Delete Delete
Save Ctrl+5

3. Click the option “New Description”:

P ——
Mew Description

New Image Gallery

[@ Save Ctrl+5

An entry will appear in the Description Tree and the “Description Details” box will open to
the right of the Description Tree:
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T *Alyxia angustissima Merr, & Quisumb, 52

Descriptions

Description Tree displayAll collapseAll

Description: Taxon description for Alyxia angustissima

q T b

[ Description Details

Edit description's label:

Taxon description for Alyxia
angustissima Merr. & Quisumb.

Name | Descri pti\.rel

9.4 Building a Description Tree by adding Descriptive Data Types

A description tree must first be created for the taxon; see the section above.

1. Point the mouse cursor at the entry in the Description Tree box.
Press the right-hand mouse button; a menu will appear.
3. Point the mouse cursor at the “New” option in the menu; a drop-down menu of all available

descriptive data types will be shown:
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T *Alyxia angustissima Merr. & Quisumb. 2 = d

Descriptions

Description Tree [ Description Details

displayAll  collapseAll

— — = — Edit description's label:
Description: Taxon description for Alyxia angustissim | t description = 1abe

Mew Description

Mew Image Gallery

| e —
< New ¥ > Abstract
[ — ]
3 Delete Delete Acknowledgments
4| T 3 Additional Publication
] Save Ctrl+5

Anatormy

Mame | Descriptive

Biology And Ecology

Citation

Common Mame
Conservation
Cultivation
Description
Diagnosis
Discussion
Distribution
Ecology
Etymology

Host Plant
Individuals Association
Introduction

Key

Materials Examined
Materials Methods
Multiple
Observation
Occurrence
Pathogen Agent
Phenology
Protologue
Specimen

Synopsis

Unknown Feature Type

Uses

4. Click on the descriptive data type that you wish to enter for the taxon, for example
“Common Name”; the data type will be added to the Description Tree and its specific data
entry box will be activated to the right of the Description Tree:

1 *Alyxia augustifolia Ridl. 3 =8
Descriptions
Description Tree displayAll collapseAll [ Common Name Details |
a Description: Taxon description for Alyxia augustifolia Ridl. Lansuase
Gwich'in v]
4 Commen Name
Mo name provided (Mo language provided) Commeon Name
b Citations add
Name | Descriptive
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A customised Descriptive Tree consisting of different description types can be created in this way. As
stated previously the format of the types of descriptive data varies; for some the data is input as free
text but for others data must be chosen from options given in a drop-down menu. Therefore
examples of how to input certain descriptive data types will be given in the following sections, rather
than showing how to input data for each data type.

9.5 Adding Common Name Descriptive Data to a Taxon Record

Add the descriptive data type of “Common Name” as described in section 8.4 above. The Descriptive
tab in the Freetext panel should look like this:

[ *Alyxia augustifolia Ridl. 23 =0

Descriptions

Description Tree displayAll collapseAll [ Common Name Details |

Language

4 Description: Taxen description for Alyxia augustifolia Ridl.

4 Common Name ’GWiCh'in .]
Mo name provided (Mo language provided) Common Mame
}» Citations 2dd

Name | Descriptive

Tip! Each individual panel of the Taxonomic Editor can be resized; if you are having difficulties
viewing the entire Descriptions panel you can use the arrows which appear at the top, bottom, left
and right of the panel to resize it (see 4.3.2 Changing Panel Sizes on page 25). In the Descriptions
box, you can also change the ratio of the size of the Description Tree box on the left to the Details
box on the right. If you hover the mouse arrow between the two boxes a left-right arrow will appear
which allows you to perform the resize.

1. Clickin the “Language” field in the Common Name Details box; the field will be highlighted
and a drop-down menu will appear:
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T *Alyxia augustifolia Ridl. 5% =8

Descriptions

Description Tree [ Common Name Details

displayAll collapseall

Language

Description: Taxon description for Alyxia augustifolia Ridl.

ich'in -
Common Name

Mo name provided (Mo language provided)
Dakota

Slavic (Other)
N Caucasian (Other)
lloke
Tupi languages
Mubian languages
Ewondo
Kabardian
Serbian
MName | Descriptive Lithuanian
Hiri Maotu
Somali
1 Kru languages
Neapolitan
Chechen
Soninke
- Tamashek

Galician
i« 1 b

>

2. Enter the first digit of the name of the language. The first language name that begins with
that letter will be shown. Continue to enter the first digit of the name until the language you
wish to select is shown in the highlighted box.

For example, to input the language of the common name as “Thai”, after clicking and
highlighting the Language field, press “T” on the keyboard. Repeat the pressing until the
name “Thai” in shown the Language field:

T *Alyxia augustifolia Ridl. 53 =8

Descriptions

Description Tree [ Common Name Details

displayAll  collapseAll

Langugge
Thai A

Description: Taxon description for Alyxia augustifolia Ridl.

Commaon Name

N ided (Mo | ided
o name provided (Mo language provided) Norse, Old

Ainu
y Mdenga
Chichewa; Chewa; Myanja
Adangme
Indonesian
Esperanto
Marathi
ljo languages
MName | Descriptive Terena
Carnish
French, Middle (ca.1400-1600)
, Kutenai
Multiple languages
Banda languages
' Eastern Frisian
Palauan

:Slovak h¥2
i i« [T b

|

3. When the language you want to select is shown in the Language field, press return on the
keyboard to confirm your selection; the drop-down menu will close and your selection will
be shown in the Language field:
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T *Alyxia augustifolia Ridl. &3 =8

Descriptions

Description Tree [ Common Name Details |

displayAll  collapseAll

e - - — Language
Description: Taxon description for Alyxia augustifelia Ridl, -
Common Name @ j>
Me name provided (Mo language provided) Common Name
b Citations add

MName | Descriptive

4. Click in the “Common Name” field in the Common Name Details box; the cursor will appear
in the box.

5. Type in the common name of the activated Taxon; the text will appear in the Common Name
field:

T *Alyxia angustissima Merr, & Quisurnb, 52 =8

Descriptions

Description Tree [ Common Name Details |

displayAll  collapsedll

Language
|Thai -|

Description: Taxon description for Alyxia angustissima
Commen Name

Ll

Me name provided (Ne language provided) Copmm "
C Dongtoh| />

+ Citations add

4| i 3

Mame Descriptive]

6. Save the changes by clicking on the Save icon:

¥, EDIT Taxonomic Edito

File Edit BulkEditor Window Help
r E

r......, Tax:mmicTree e = Eq[

Please Note: the Common Name menu in the Description Tree is not visibly updated at this point.
However, if you close the Common Name menu and then re-open it by clinking twice on the arrow
to the left, you will see that the data you have input has been saved (see below). Also, you will
notice that as you close the Common Name menu, the Common Name Details box to the right of the
Description Tree will also close.
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Descriptions

Description Tree displayAll collapseAll

4 cription: Taxon description for Alyxia angustissima M
omman MName

Dongtoh (Thai)

9.6 Adding a Species Description to a Taxon Record

Add the descriptive data type of “Description” as described in section 8.4 above. The Descriptive tab
in the Freetext panel should look like this:

T *Alyxia angustissima Merr. & Quisumnb. &3 = B8

Descriptions

»

Description Tree [ Description Details |

displayAll  collapseAll

— - : P Text for this descriptive el t:
4 Description: Taxon description for Alyxia angustissima Brinis Cescriplive Eemen

a4 Common Mame
Dongtoh (Thai)
a Description
No text provided

m

4| i 3

Mame | Descriptive

As with several other descriptive data types available, the description of a species is added as free
text.

1. Point the mouse cursor in the Description Details box; the cursor will appear.
2. Type in your species description, for example:

3 *Alyxia angustissima Merr. & Quisurnb, 23 =

Descriptions

| »

Description Tree [ Description Details

displayAll  collapseAll

- - : - Teut for this descriptive el t
Description: Taxon description for Alyxia angustissima M Orinis Cesenptive Eiemen

Commaon Mame
Dongtoh (Thai)

Climbers. Branchlets weakly angled, sparsely -
lanticellate, sparsely puberulent, sometimes
glabrescent. Leaves in whorls of 3-5; peticle 0.1-

m

Description 0.3cm long, glabrous or pubescent. i
Mo text provided
1| 1 3
Name DescriptiveJ

Tip! You can also cut and paste text from a word document or another database where you store
taxonomic information. Simply highlight the text you want to copy from the original document, press
Ctrl on your keyboard and then C whilst still holding the Ctrl button. Release both buttons. You have
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just copied the text. Now click in the box of the Taxonomic Editor where you would like to paste the
text and press Ctrl and then V whilst still holding the Ctrl button. The text will be pasted.

3. Save the changes by clicking on the Save icon:

32 EDIT Taxonomic Editol

File Edit BulkEditor Window Help

Please Note: the Description menu in the Description Tree is not visibly updated at this point.
However, if you close the Description menu and then re-open it by clinking twice on the arrow to the
left, you will see that the data you have input has been saved (see below). Also, you will notice that
as you close the Description menu, the Description Details box to the right of the Description Tree

will also close.
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